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1 Introduction

1

Introduction

1.1

Target group
This documentation is aimed at users with the following knowledge and skills:


Advanced knowledge of the robot controller system



Advanced knowledge of bus technologies

For optimal use of our products, we recommend that our customers
take part in a course of training at KUKA College. Information about
the training program can be found at www.kuka.com or can be obtained directly from our subsidiaries.

1.2

Representation of warnings and notes
These warnings are relevant to safety and must be observed.

Safety

These warnings mean that it is certain or highly probable
that death or severe physical injury will occur, if no precautions are taken.
These warnings mean that death or severe physical injury may occur, if no precautions are taken.
These warnings mean that minor physical injuries may
occur, if no precautions are taken.
These warnings mean that damage to property may occur, if no precautions are taken.
These warnings contain references to safety-relevant information or
general safety measures. These warnings do not refer to individual
hazards or individual precautionary measures.
These hints serve to make your work easier or contain references to further
information.

Notes

Tip to make your work easier or reference to further information.

1.3

Trademarks
Windows is a trademark of Microsoft Corporation.
Pentium is a trademark of Intel Corporation.
Step 7 are trademarks of Siemens AG.
PC WORX is a trademark of Phoenix Contact.

1.4

Licenses
This KUKA software product uses open-source software. The licensing terms
are displayed during installation of the KUKA software product.
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1.5

Terms used
Term

Description

DTM

Device Type Manager

KCP

KUKA Control Panel
General name for KUKA teach pendants

8 / 141

KRL

KUKA Robot Language

KSS

KUKA System Software

KUKA smartHMI

Name of the graphical user interface for the
(V)KR C4 robot controller

KUKA smartPAD

Name of the KCP for the (V)KR C4 robot controller

Issued: 29.03.2012 Version: KST WorkVisual 2.4 V3 en

2 Product description

2

Product description
The WorkVisual software package is the engineering environment for KR C4
controlled robotic cells. It offers the following functionalities:


Configuring and connecting field buses



Programming robots offline



Configuring RoboTeams offline



Editing the safety configuration



Transferring projects to the robot controller



Transferring projects from the robot controller to WorkVisual



Comparing a project with another project and accepting differences where
necessary



Managing long texts



Managing option packages



Diagnostic functionality



Online display of system information about the robot controller



Configuring traces, starting recordings, evaluating traces (with the oscilloscope)

Fig. 2-1: WorkVisual graphical user interface
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3

Safety
This documentation contains safety instructions which refer specifically to the
software described here. The fundamental safety information for the industrial
robot can be found in the “Safety” chapter of the Operating and Programming
Instructions for System Integrators or the Operating and Programming Instructions for End Users.
The “Safety” chapter in the operating and programming instructions
must be observed. Death to persons, severe physical injuries or considerable damage to property may otherwise result.
WorkVisual can be used with write access to modify outputs in the robot controller, without this being noticed by
any persons located inside the system.
In the test modes, such access is not permitted. Outputs of the robot controller must not be modified using WorkVisual (“Single Point of Control” principle)! Death to persons, severe physical injuries or considerable damage to
property may otherwise result.
WorkVisual can be used with write access to modify programs, I/O assignments, signal declarations and other
parameters in the robot controller. The following applies here:
New or modified programs must always be tested first in Manual Reduced
Velocity mode (T1).
After modifications to the industrial robot, existing programs must always be
tested first in Manual Reduced Velocity mode (T1). This applies to all components of the industrial robot and includes modifications to the software and
configuration settings. In particular, this also applies when a WorkVisual project has been activated on the robot controller.
After importing a safety configuration or parts thereof, the
safety configuration must be checked! If this is not done,
this can lead to the possibility of the robot being operated with incorrect data
when the project is transferred to the real robot controller. Death to persons,
severe physical injuries or considerable damage to property may result.
When activating a project on the KUKA smartHMI, an
overview is displayed of the changes which will be made
in comparison to the project that is still active on the robot controller.
If changes are listed in the overview under the heading Safety-relevant
communication parameters, this means that the behavior of the Emergency Stop and “Operator safety” signal may have changed compared with the
previous project.
After activation of the project, the Emergency Stop and the “Operator safety”
signal must be checked for safe functioning. If the project is activated on several robot controllers, this check must be carried out for every robot controller. Failure to carry out this check may result in death to persons, severe
physical injuries or considerable damage to property.
After activation of a project on the robot controller, the
safety configuration must be checked there! If this is not
done, the robot will possibly be operated with incorrect data. Death to persons, severe physical injuries or considerable damage to property may result.
(>>> 13.6 "Checking the safety configuration of the robot controller"
Page 110)
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If the activation of a project fails, an error message is displayed in WorkVisual. In this case, one of the following
measures must be carried out:
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Either: Activate a project again (the same one or a different one).



Or: Reboot the robot controller with a cold restart.
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4 Installation

4

Installation

4.1

PC system requirements

Hardware

Minimum requirements


PC with Pentium IV processor, min. 1500 MHz



512 MB RAM



DirectX8-compatible graphics card with a resolution of 1024x768 pixels

Recommended specifications

Software



PC with Pentium IV processor and 2500 MHz



1 GB RAM



DirectX8-compatible graphics card with a resolution of 1280x1024 pixels



Windows XP incl. Service Pack 2.0
Or Windows 7



4.2



KUKA.PLC Multiprog 5-35 4.0 must be installed.



Multiprog must be licensed.

System requirements, robot controller

Software

4.3

If Multiprog is to be interfaced with WorkVisual:



KUKA System Software 8.1 or 8.2



Or VW System Software 8.1 or 8.2

Installing WorkVisual
Local administrator rights

Precondition



Procedure

1. Start the program setup.exe.
2. If the following components are not yet installed on the PC, an installation
wizard opens:


.NET Framework 2.0, 3.0 and 3.5

Follow the instructions in the installation wizard. .NET Framework is installed.
3. If the following component is not yet installed on the PC, an installation
wizard opens:


SQL Server Compact 3.5

Follow the instructions in the installation wizard. SQL Server Compact 3.5
is installed.
4. If the following components are not yet installed on the PC, an installation
wizard opens:


Visual C++ Runtime Libraries



WinPcap

Follow the instructions in the installation wizard. Visual C++ Runtime Libraries and/or WinPcap is installed.
5. The WorkVisual […] Setup window opens. Click on Next.
6. Accept the license agreement and click on Next.
7. Select the directory and click on Next.
8. Click Install. WorkVisual is installed.
9. Once installation is completed, click on Finish to close the installation wizard.
Issued: 29.03.2012 Version: KST WorkVisual 2.4 V3 en
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4.4

Uninstalling WorkVisual
It is advisable to archive all relevant data before uninstalling a software package.

Precondition

Procedure



Local administrator rights



The setting Show hidden files and folders is activated in Windows Explorer.

1. In the Windows Start menu, select Settings > Control Panel > Software,
and delete the entry WorkVisual […].
Steps 2-6 are only necessary if the entire user configuration is to be
deleted.
2. In the directory C:\Program Files\KUKA, delete the folder WorkVisual [...].
3. In the directory C:\Documents and Settings\Username\Application Data\KUKA Roboter GmbH, delete the folder WorkVisual.
4. In the directory C:\Documents and Settings\All Users\Application Data\KUKA Roboter GmbH, delete the folder WorkVisual.
5. Delete the WorkVisual Projects folder in the My Documents directory.
6. In the directory C:\Documents and Settings\All Users\Application Data\KUKA Roboter GmbH, delete the folder DeviceDescriptions.

14 / 141
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5 Graphical user interface

5

Graphical user interface

5.1

Overview of the graphical user interface
Not all elements on the graphical user interface are visible by default, but they
can be shown or hidden as required.
There are other windows and editors available in addition to those shown here.
These can be displayed via the Window and Editors menus.

Fig. 5-1: Overview of the graphical user interface
Item

Description

1

Menu bar

2

Button bars
(>>> 5.5 "Displaying/hiding buttons" Page 18)
(>>> 5.6 "Button bar" Page 19)

3

Editor area
If an editor is open, it is displayed here. More than one editor can
be open simultaneously – as shown here in the example. In this
case, they are stacked one on top of the other and can be selected
via tabs.

4

Help button

5

Project structure window

Issued: 29.03.2012 Version: KST WorkVisual 2.4 V3 en
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Item
6

Description
Catalogs window
All catalogs added are displayed in this window. The elements in
the catalogs can be inserted by Drag&Drop on the Hardware or
Geometry tabs in the Project structure window.

7

Workspace Selection window
(>>> 5.4 "Displaying different views of the user interface"
Page 18)

8

Messages window
(>>> 5.7 "Messages window" Page 21)

9

Properties window
If an object is selected, its properties are displayed in this window.
The properties can be changed. Individual properties in gray boxes
cannot be changed.

5.2

Displaying/hiding windows

Procedure

1. Select the menu item Window. A list of available windows opens.
2. Click on a window in the list in order to display or hide it on the graphical
user interface.

5.3

Repositioning the windows
The desired window is displayed on the graphical user interface.

Precondition



Procedure

Free positioning of windows:
1. Right-click in the title bar of the window. A context menu is opened.
2. Select the option Floating.
3. Grip the window by the title bar and move it to the desired position on the
graphical user interface.
If the mouse pointer is positioned over the edges or corners of the window, arrows appear which can be dragged to make the window larger or smaller.
Fixed positioning of windows:
1. Right-click in the title bar of the window. A context menu is opened.
2. Select the option Dockable.
3. Grip the window by the title bar and move it to the desired position on the
graphical user interface.


Anchor points are displayed at the right, left, top and bottom of the user
interface.



If the window is moved over another fixed window, an anchor cross is
displayed.
(>>> "Anchor cross" Page 17)

4. Drag the window onto an anchor point or the cross. The window is now anchored.
Automatic hiding and displaying of anchored windows:
1. Right-click in the title bar of the window. A context menu is opened.
2. Select the option Auto-Hide. The window is hidden. A tab with the name
of the window remains at the edge of the user interface.
3. To show the window again, move the mouse pointer over the tab.

16 / 141
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4. To hide the window again, move the mouse pointer off the window. If necessary, click on an area outside the window.
The Auto-Hide option creates more space for working in other areas of the
user interface. Nonetheless, the window can still be quickly shown again at
any time.
There is a pin symbol in the title bar of the window.


Alternatively, Auto-Hide can also be activated or deactivated by clicking
on this pin symbol.

Fig. 5-2: Pin symbol
Anchor cross

If a window is moved over another fixed window, an anchor cross is displayed.

Fig. 5-3: Anchor cross
Depending on which side of the anchor cross the window is dragged, it is then
anchored on this side of the previously window.
If the window is dragged over to the center of the anchor cross, both windows
are anchored one on top of the other. Tabs are displayed underneath the windows, making it possible to switch between windows.

Fig. 5-4: Windows anchored on top of each other

Issued: 29.03.2012 Version: KST WorkVisual 2.4 V3 en
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To move windows that are anchored one on top of the other:

5.4



Dragging on a tab moves only the corresponding window.



Dragging on the title bar moves the whole stack of windows.

Displaying different views of the user interface

Description

The WorkVisual user interface can be displayed in 2 different views. These
can be selected via the menu item View or via the Workspace Selection window.
The views are tailored to different types of work:
View

Focus

Programming and
configuration

Area for project-related work

Online administration

Area for project-independent work

For example: cell configuration, I/O mapping and
work with the KRL Editor.
e.g. monitoring, recording
The functions in this view are only available
when there is no project opened.

Each view can be adapted separately to the needs of the user. Examples:

Procedure



Position the button bars differently in each view.



Hide the message window in one view and not in another.

Show the Workspace Selection window:


Select the menu sequence Window > Workspace Selection.

Fig. 5-5: Workspace Selection window
To reset the current view to the default settings:


Select the menu sequence Window > Reset active workspace.

To reset the all views to the default settings:


5.5

Select the menu sequence Window > Reset all workspaces.

Displaying/hiding buttons

Description

The individual buttons can be added or removed. In this way, the button bar
can be tailored to the needs of the user.

Procedure

1. Click on the arrow on the right of the button bar.

Fig. 5-6: Example: File button bar: Click on the arrow on the right
2. The menu item Add or Remove Buttons is displayed. Click on this, and
then on the submenu item [BarName].

18 / 141

Issued: 29.03.2012 Version: KST WorkVisual 2.4 V3 en

5 Graphical user interface

3. An overview of all the buttons in this bar is displayed. Click on a button in
the overview in order to add or remove it.

Fig. 5-7: Example: File button bar: Overview

5.6

Button bar
Button

Name / description
New…
Opens a new, empty project.
Open project
Opens the Project Explorer.
Save project
Saves the project.
Cut
Deletes the selected element from its original position and
copies it to the clipboard.
Copy
Copies the selected element to the clipboard.
Paste
Inserts the cut or copied element at the selected position.
Delete
Deletes the selected element.
Opens the Add Point dialog.
Opens a window in which an element can be selected and
added to the tree structure. The elements offered depend on
the element that is selected in the tree structure.
Example: If a robot controller is selected in the tree structure,
elements such as robots and external axes are offered in the
window for adding.
The button is only active if an element is selected on the Hardware or Files tab of the Project structure window.
Set as active controller / Reset active controller
Sets a robot controller to active/inactive.
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Button

Name / description
Undo
Undo the last action.
Redo
Redoes the action that was undone.
Settings…
Opens a window with the hardware data.
The button is only active if a device is selected on the Hardware tab of the Project structure window.
Connect with device
Establishes a connection with a field bus device.
The button is only active if the field bus master is selected on
the Hardware tab of the Project structure window.
Disconnect from device
Terminates the connection with a field bus device.
Scan Topology…
Scans a bus.
Abort last action
Cancels certain actions, e.g. a bus scan.
The button is only active if a cancelable action is running.
Monitor
Currently without function.
Diagnosis…
Currently without function.
Deploy…
Transfers the project to the robot controller.
Generate code
(>>> 13.1 "Generating code" Page 101)
Opens the I/O Mapping Editor
Opens the I/O Mapping window.
The local safety configuration of the controller
Opens the local safety configuration of the current robot controller.
KRL Editor
Opens the current file in the KRL Editor.
The button is only active if a file is selected on the Files tab of
the Project structure window which can be opened with the
KRL Editor.
Symbol Table Editor
Opens the Symbol Table Editor window.
Help
Opens the Help.

Only in the Online administration workspace:
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Button

Name / description
Opens an editor for online system information
Diagnostic monitor
Displays the Diagnostic monitor window. The button is only
active in the Diagnosis view.
Opens the Trace Configuration Editor.
Opens the Trace configuration window.
Opens the trace analysis editor (oscilloscope).
Opens the Trace Analysis window.

5.7

Messages window

Description

Messages are displayed here. The following options can be set in the message window:
Language:
The desired language can be selected here.
Category:


Message history: Displays all messages except errors relating to KRL
code.
Messages are not automatically deleted, even if they refer to a temporary
state that is no longer active. Messages can be deleted by right-clicking on
them and selecting the option Delete all.



5.8

KRL Parser: Display of errors in the KRL code of the file currently open in
the KRL Editor window.

Project structure window
The Project structure window contains the following tabs:

Hardware

The Hardware tab shows the relationship between the various devices. Here,
the individual devices can be assigned to a robot controller.

Geometry

The Geometry tab displays all the geometrical objects used in the project in a
tree structure (kinematic systems, tools, base objects). The properties of the
objects can be edited.
If objects need to be linked geometrically, e.g. if a robot is to be assigned to a
KUKA linear unit: this must be done here on the Geometry tab (Drag&Drop).
The Files tab contains the program and configuration files belonging to the
project.

Files

Coloring of file names:

5.9



Files generated automatically (with Generate code function): gray



Files inserted manually in WorkVisual: blue



Files transferred to WorkVisual from the robot controller: black

Resetting the graphical user interface

Description

All the settings affecting the graphical user interface and its behavior that the
user has made in WorkVisual can be reset to the default state (as after installation).
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This includes changes to the button bars, windows that have been displayed
or hidden, and settings made in the Options window.
Procedure

1. Select the menu sequence Window > Reset configuration.
2. Close WorkVisual and restart it.
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6

Operation

6.1

Starting WorkVisual

Procedure

1. Double-click on the WorkVisual icon on the desktop.
2. When WorkVisual is started for the first time, the DTM Catalog Management is opened. Here a catalog scan must be carried out.
(>>> 6.9 "Inserting the field bus master in the DTM Catalog (Catalog
Scan)" Page 26)

6.2

Opening a project

Description

This procedure is used to open a project.
Projects can also be opened from older versions of WorkVisual. WorkVisual
creates a backup copy of the older project and then converts the project. Before this happens, a dialog is displayed requesting the user to confirm the conversion.

Procedure

1. Select the menu sequence File > Open project.
Or: Click on the Open project button.
2. The Project Explorer is opened. On the left, the Open project tab is selected. A list of projects is displayed.
Select a project and click on Open. The project is opened.
3. Set the robot controller as the active controller.

Fig. 6-1: Project Explorer
Alternative
procedure

1. Select the menu sequence File > Recent projects. A submenu containing
recently opened projects is opened.
2. Select a project. The project is opened.
3. Set the robot controller as the active controller.
Projects which are located on a robot controller and have not yet been saved
on this PC can also be transferred to WorkVisual and opened there. To do this,
a different procedure must be used:
(>>> 13.7 "Transferring a project from the robot controller to WorkVisual"
Page 110)
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6.3

Creating a new project

6.3.1

Creating a new empty project

Procedure

1. Click on the New… button. The Project Explorer is opened. On the left,
the Create project tab is selected.
2. Select the Blank project template.
3. Enter a name for the project in the File name box.
4. The default directory for projects is given in the Location box. If required,
select a different directory.
5. Click on the New button. A new, empty project is opened.

6.3.2

Creating a project with a template

Procedure

1. Click on the New… button. The Project Explorer is opened. On the left,
the Create project tab is selected.
2. Select the desired template in the Available templates area of the tab.
3. Enter a name for the project in the File name box.
4. The default directory for projects is given in the Location box. If required,
select a different directory.
5. Click on the New button. The new project is opened.

Templates

6.3.3

The templates available for selection include:
Template

Description

Blank project

Blank project

KR C4 project

This project contains a KR C4 controller and the
catalog KRL Templates.

VKR C4 project

This project contains a VKR C4 controller and
the catalog VW Templates.

Creating a project on the basis of an existing project

Procedure

1. Click on the New… button. The Project Explorer is opened. On the left,
the Create project tab is selected.
2. Select the desired project in the Available projects area of the tab.
3. Enter a name for the new project in the File name box.
4. The default directory for projects is given in the Location box. If required,
select a different directory.
5. Click on the New button. The new project is opened.

6.4

Saving project information

Description

If required, the user can assign information to the project. The following information can be saved:


A description



A preview image (screenshot)

The following information is saved and displayed by default:
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The version



The creation date and change date



The current file location



The project ID
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A project is open.

Precondition



Procedure

1. Select the menu sequence Extras > Project info. The window Project
info for ... is opened.
2. Enter a description in the Description box (optional).
3. Click on the Insert image from file button (optional). Select an image and
confirm with Open.
4. Click on OK. The window Project info for ... is closed and the project information is saved.

6.5

Saving the project

Description

Projects have the file format WVS ("WorkVisual Solution").
A project can be saved with one of the following functions:


Save: Saves the open project.



Save as: This function is used to save a copy of the open project.
The open project itself is closed and remains unchanged.
Select the menu sequence File > Save.

Procedure for
Save



Procedure for
Save as

1. Select the menu sequence File > Save as.

Or click on the Save project button.

The Save as window is opened. A file location for the project can be selected here.
2. Enter a name in the File name box and click on the Save button.

6.6

Closing the project

Procedure



Select the menu sequence File > Close.
If changes have been made, a request for confirmation is displayed, asking if the project should be saved.

6.7

Closing WorkVisual

Procedure



Select the menu sequence File > Exit.
If a project is open, a request for confirmation is displayed, asking if the
project should be saved.

6.8

Importing device description files

Description

To be able to use a device in WorkVisual, WorkVisual requires the device description file for this device.
The device description files must be obtained from the manufacturer
of the devices.
There is no project open.

Precondition



Procedure

1. Select the menu sequence File > Import / Export. The Import/Export
Wizard window is opened.
2. Select Import device description file and click on Next >.
3. Click on Browse… and navigate to the directory where the files are located. Confirm with Next >.
4. A window opens. Select the desired robot type in the File type box.
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5. Select the file to be imported and confirm with Open.
6. Click on Finish.
7. Close the Import/Export Wizard window.

6.9

Inserting the field bus master in the DTM Catalog (Catalog Scan)

Description

This procedure only needs to be carried out when WorkVisual is started for the
first time after installation.

Procedure

1. The DTM Catalog Management window opens automatically.
If necessary, it can also be opened via the menu sequence Extras > DTM
Catalog Management....
2. Click on Search for installed DTMs. WorkVisual searches the PC for relevant files. The search results are displayed.
3. Under Known DTMs, select the required files and click on the Right arrow button.
If all files are to be accepted, click on the Double right arrow button.
4. The selected files are displayed under Current DTM Catalog. Click on
OK.

Fig. 6-2: DTM Catalog Management

6.10

Inserting a catalog in a project

Description

The catalogs contain all the elements that are required to generate programs.
In order to be able to use a catalog, it must first be inserted in the project.
The following catalogs are available by default in WorkVisual:
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Catalog

Description

DtmCatalog

Device description files

KRL Templates

Templates for KRL programs

KukaControllers

Robot controllers

KukaExternalAxis

External axes

KukaMisc

Demonstration workpieces

KukaRobotsKRC4
[…]

Several catalogs with robot models for KR C4
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Procedure

Catalog

Description

KukaSpecialRobots

Special robot models

VW Templates

Templates for VW programs

1. Select the menu sequence File > Catalog management.... A window
opens.
2. Double-click on the desired catalog in the Available catalogs area. The
catalog is now displayed in the Project catalogs area.
3. Close the window.
The catalog has been inserted in the project. It is now available in the Catalogs window.

6.11

Removing a catalog from the project

Procedure

1. Select the menu sequence File > Catalog management.... A window
opens.
2. Double-click on the catalog to be removed in the Project catalogs area.
The catalog is now displayed in the Available catalogs area.
3. Close the window.

6.12

Inserting a robot controller in a project

Description

One or more robot controllers can be inserted in a project.

Precondition



Procedure

1. Select the Hardware tab in the Project structure window.

The catalog KukaControllers is available.

2. Select the required robot controller in the KukaControllers catalog.
3. Drag the robot controller to Cell: Hardware view on the Hardware tab.

6.13

Setting the robot controller to active/inactive

Description

Most settings, actions and configurations performed in the Programming and
configuration workspace are only possible if a robot controller is active. Furthermore, they apply to the currently active robot controller (e.g. settings in the
safety configuration and I/O mappings).
If a project contains more than one robot controller, ensure that the
correct robot controller is active.
A robot controller has been added.

Precondition



Procedure

Setting the robot controller as the active controller:
1. Double-click on the inactive robot controller on the Hardware tab in the
Project structure window.
2. Only if the robot controller is set to active for the first time: A window opens.


Firmware version box: Enter the version of the KUKA/VW System
Software that is installed on the real robot controller: e.g. “8.2.15”.



Number of I/Os box: Select the maximum number of inputs/outputs
used on the robot controller.

The values can be changed subsequently. The correct values are necessary for code generation and project deployment.
(>>> 6.14 "Changing the values “Firmware version” and/or “Number of I/
Os”" Page 28)
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3. Click on OK to save.
Instead of double-clicking, it is also possible to right-click on the robot controller. A context menu is opened. Select the option Set as active controller.
Setting the robot controller to inactive:
For a small number of actions in WorkVisual, it is necessary to set the robot
controller to inactive. If these actions are started, a message is displayed to
inform the user that the robot controller must first be set to inactive.
1. Save the project.
2. Double-click on the active robot controller on the Hardware tab in the
Project structure window.
Instead of double-clicking, it is also possible to right-click on the robot controller. A context menu is opened. Select the option Set as inactive controller.

6.14

Changing the values “Firmware version” and/or “Number of I/Os”

Description

When the robot controller is set to active for the first time, the values Firmware
version and Number of I/Os must be adapted or confirmed.
(>>> 6.13 "Setting the robot controller to active/inactive" Page 27)
The values can be changed subsequently. The correct values are necessary
for code generation and project deployment.

Procedure

1. Save the project.
2. Right-click on the robot controller on the Hardware tab in the Project
structure window.
3. Select Controller options from the context menu. The Controller options window is opened.
4. Enter the new value in the Firmware version box: e.g. “8.2.16”.
And/or: Select a different number in the Number of I/Os box.
5. Click on OK to save.

6.15

Removing a robot controller from a project

Procedure

1. Select the Hardware tab in the Project structure window.
2. Right-click on the robot controller in the Hardware tab. Select Delete from
the context menu.
Alternatively:
Select the robot controller on the Hardware tab. Select the menu sequence Edit > Delete.
Alternatively:
Select the robot controller on the Hardware tab and click on the Delete
button in the toolbar or press the Delete key on the keyboard.
The robot controller is removed from the tab.

6.16

Assigning a robot to the robot controller

Description
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In the following cases, it is necessary to assign a robot to the robot controller:


If you want to open the local safety configuration of a robot controller which
has not yet been assigned a safety configuration.



If you want to import the robot’s machine data to the local safety configuration.
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Precondition

Procedure



The catalog containing the required robot has been inserted in the Catalogs window.



The robot controller has been set as the active controller.

1. Select the Hardware tab in the Project structure window.
2. Select the required robot in the KukaRobots catalog in the Catalogs window.
3. Drag the robot onto the robot controller in the Hardware tab. (Not onto the
node Unassigned active devices.)
The robot is now displayed underneath the robot controller.

Alternative
procedure

1. Select the Hardware tab in the Project structure window.
2. Right-click on the robot controller and select Add….
3. A window opens. Select the catalog KukaRobots.
4. Select the required robot from the list and click on the Add button.
The robot is now displayed underneath the robot controller.

6.17

Adding an external axis
During project planning, please note the following: If a project is transferred from the robot controller to WorkVisual using Extras > Compare projects, then external axes which were added or deleted in the
project on the robot controller are not transferred to WorkVisual with the rest
of the project.
(>>> 13.8 "Comparing projects (and accepting differences)" Page 110)

Preparation

In order for an external axis to be inserted into the project, the file structure of
the robot controller must be present on the Files tab in the Project structure
window. This can be achieved as follows:


Do not create a new project in WorkVisual, but transfer the initial project
from the robot controller to WorkVisual.
(Menu sequence: File > Browse for project.)
(>>> 13.7 "Transferring a project from the robot controller to WorkVisual"
Page 110)



Or: Transfer the project to the robot controller and back to WorkVisual
again.
(Menu sequence: Extras > Compare projects.)
(>>> 13.8 "Comparing projects (and accepting differences)" Page 110)

Precondition

Procedure



The KukaExternalAxis catalog has been inserted in the Catalogs window.



The robot controller has been set as the active controller.

1. Select the Hardware tab in the Project structure window.
2. Select the required robot in the KukaExternalAxis catalog in the Catalogs window.
3. Drag the external axis onto the robot controller in the Hardware tab. (Not
onto the node Unassigned active devices.)
The external axis is now displayed underneath the robot controller.
4. Select the external axis and select the menu sequence Editors > Machine data configuration. The Machine data configuration window is
opened.
5. In the Axis ID: box in the area General axis-specific machine data,
specify which drive the external axis is assigned to in the real cell.

Issued: 29.03.2012 Version: KST WorkVisual 2.4 V3 en

29 / 141

WorkVisual 2.4

6. If required: edit the other parameters.
7. If the external axis needs to be linked geometrically to a kinematic system:
a. Select the Geometry tab.
b. Assign the kinematic systems to each other as required by means of
Drag&Drop.
Example 1: If a KUKA linear unit has been added, drag the robot onto
the linear unit.
Example 2: If a servo gun (KUKA.ServoGun package) has been added
that is to be used on the robot flange, drag the gun onto the Flange
Base node of the robot.

6.18

Option packages

6.18.1

Installing an option package in WorkVisual

Description

Option packages, e.g. technology packages, can be installed in WorkVisual.
This makes it possible to insert the catalog of the option package in the individual projects, if required. The option package is then available for use in this
project.
Advantage: if a project is transferred to a number of robot controllers, the settings relevant to the package only need to be carried out once in WorkVisual
and not on each individual robot controller.

Precondition



The option package is available as a KOP file.
The KOP file is located on the CD of the option package. (Not yet available
for all KUKA option and technology packages.)



Procedure

There is no project open.

1. Select the menu sequence Extras > Option package management....
The Option package management window is opened.
2. Click on the Install... button. The Select the package to be installed window is opened.
3. Navigate to the path where the option package is located and select it.
Click on Open.
4. The package is installed. If the KOP file contains device description files,
the Update catalog window opens and closes during this operation.
Once the operation has been completed, the package is displayed in the
Installed option packages area of the Option package management
window.

Fig. 6-3: Installed option packages
5. Only if the message The application must be restarted for the changes to take
effect is displayed:
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Either: click on the Restart button. WorkVisual restarts.



Or: close the Option package management window and restart
WorkVisual later.
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6. Only if the message stated in the previous step is NOT displayed: Close
the Option package management window.
The catalog of the option package is now available under File > Catalog management....
If the KOP file contains device description files, these are now available in
WorkVisual. It is not necessary to perform a catalog scan.
6.18.2

Updating an option package

Description

Only option packages which do not contain an expansion for WorkVisual (e.g.
an additional editor) can be updated. Other option packages must first be uninstalled before the new version can be installed.
For the user, it is not apparent beforehand whether a package is updatable or
not. The update process can be started nonetheless. If the previous version
has to be uninstalled first, WorkVisual displays a message to this effect.
There is no project open.

Precondition



Procedure

1. Select the menu sequence Extras > Option package management....
The Option package management window is opened.
2. Click on the Install... button. The Select the package to be installed window is opened.
3. Navigate to the path where the option package is located and select it.
Click on Open.
4. One of the following messages is displayed.


Updating option packages with plug-ins is not possible. Please
uninstall '{0}' before updating.
Confirm the message with OK. Do not continue with step 5, but uninstall the package. Then install the new version.



The package has already been installed. Update the package to
the selected version?
Confirm the message with Yes.
The package is installed. If the KOP file contains new device description files, the Update catalog window opens and closes during this operation.

5. Only if the message The application must be restarted for the changes to take
effect is displayed:


Either: click on the Restart button. WorkVisual restarts.



Or: close the Option package management window and restart
WorkVisual later.

6. Only if the message stated in the previous step is NOT displayed: Close
the Option package management window.
6.18.3

Uninstalling an option package
There is no project open.

Precondition



Procedure

1. Select the menu sequence Extras > Option package management....
The Option package management window is opened.
2. In the Installed option packages area, click on the red “X” to the right of
the name of the package.
3. Only if the option package is now hidden in the Installed option packages area: Close the Option package management window.
Uninstallation is now complete. No further steps are necessary.
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4. Only if the message The application must be restarted for the changes to take
effect is displayed:


Either: click on the Restart button. WorkVisual restarts.



Or: close the Option package management window and restart
WorkVisual later.

If an option package that is used in a project is uninstalled and this project is
opened again, the user is prompted to open the catalog for the option package.
If the catalog is not opened, WorkVisual displays the following warning in the
message window: The following option packages of the project are not installed in WorkVisual: {Name}
6.18.4

Inserting the catalog of the option package into the project

Description

If an option package is to be used in a project, the catalog of the option package must be added to this project.

Precondition



Procedure
6.18.5

The option package has been installed in WorkVisual.

(>>> 6.10 "Inserting a catalog in a project" Page 26)

Removing the catalog of the option package from the project
Elements from the catalog that are used in the project are retained
even if the catalog is removed from the project.

Procedure
6.18.6

(>>> "Procedure" Page 27)

Inserting an option package in a project
This action is not necessary if a device is added to the project from
the option package. In this case, the option package is also inserted
automatically.

Description

In order to be able to use an option package on the real robot controller, it must
be inserted into the project in WorkVisual.
If a project containing an option package is transferred to the robot
controller, the procedure differs from the normal deployment procedure. Further information can be found in the section on project deployment.
(>>> 13.4 "Transferring the project to the robot controller" Page 104)

Precondition
Procedure



The catalog of the option package has been added to the project.

1. Select the Hardware tab in the Project structure window.
2. Right-click on the Options node and select Add….
3. A window opens. Select the catalog of option package.
4. The uppermost element in the catalog is always the option package. Select this and click on the Add button.
The option package is now displayed in the Options node.
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6.18.7

Removing an option package from the project

Precondition



The robot controller has not been assigned any devices from this option
package.
Any devices assigned must first be removed.

Procedure

1. Select the Hardware tab in the Project structure window.
2. Expand the Options node. All the option packages contained in the project are displayed.
3. Right-click on the package to be removed and select Delete.
The option package is removed from the Options node.

6.18.8

Adding a device from an option package to the robot controller

Description

In order to be able to use devices from the option package on the real robot
controller, the devices must be inserted into the project in WorkVisual.
A device is a catalog element to which the following configurations can be assigned:


Configuration of the device



Bus configuration



I/O connections



Long texts

A device is e.g. a weld controller from KUKA.ArcTech.
The catalog of the option package has been added to the project.

Precondition



Procedure

1. Select the Hardware tab in the Project structure window.
2. Right-click on the robot controller and select Add….
3. A window opens. Select the catalog of option package.
4. Select the required device from the list and click on the Add button.
5. If there are already configurations assigned to the device, a message is
displayed asking if these configurations are to be transferred to the project.
Select Yes or No as appropriate.
6. If I/O connections were transferred together with the device, the Adjust
signal connections window is opened. (>>> Fig. 6-4 )
If the signals to which the device is to be connected in accordance with its
default settings are already mapped in the current project, this is shown in
the Current conflicts area.
7. If signals are displayed in the Current conflicts area:
If desired, change the start addresses for the different I/O types until no
further conflicts are displayed.
8. Either: Click on OK. Any signals remaining in the Current conflicts area
are now overwritten with the new connections.
A message is displayed in the message window for each overwritten connection. This makes it easier in the case of later changes.
Or: Click on Cancel. The device is inserted in the Project structure window, but no signal connections are adopted.
The device is now displayed underneath the robot controller.
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Fig. 6-4: Adjust signal connections

6.18.9

Exporting a subproject

Description

This procedure enables parts of projects to be exported, e.g. a device and/or
I/O connections. Subprojects can be processed further with the KUKA.OptionPackageEditor. The KUKA.OptionPackageEditor is a software product for
manufacturers of technology packages and system integrators for the creation
of option packages.
Subprojects have the file format WVPS (“WorkVisual Partial Solution”).

Precondition

Procedure



A project is open.



The robot controller has not been set as the active controller.

1. Select the menu sequence File > Import / Export. A window opens.
2. Select the entry Export subproject. The window is now called Export
subproject.
Click on Next.
3. All the controllers of the project are displayed. Select the controller from
which data is to be exported and confirm with Next.
4. A tree structure is displayed. In the tree structure, activate the check boxes
for the elements that are to be exported. Confirm with Next.
5. Select a path for saving the subproject and click on Finish. The subproject
is exported.
6. If the export was successful, this is indicated by the following message in
the Export subproject window: Partial export successful.
Close the window.

6.19

Changing predefined properties of WorkVisual

6.19.1

Overview
The appearance and the predefined properties of WorkVisual can be changed
in the Options window.
The window contains various folders:
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Folder

Description

Text editor

The KRL Editor can be configured here.
(>>> 12.4.4 "Configuring the KRL Editor" Page 91)

Environment

Options for booting and saving can be configured
here, together with keyboard shortcuts.
(>>> 6.19.2 "Configuring booting and saving characteristics" Page 35)
(>>> 6.19.3 "Configuring keyboard shortcuts"
Page 35)

Localization

The language of the user interface can be changed
here.
(>>> 6.19.4 "Changing the user interface language"
Page 36)

Fig. 6-5: Options window

6.19.2

Configuring booting and saving characteristics

Procedure

1. Select the menu sequence Extras > Options. The Options window is
opened.
2. In the Environment folder, select the subitem ObjectStoreUI.
3. Make the desired settings.
4. Confirm the changes made with OK.

Description

Subitem ObjectStoreUI:
Parameter

Description

Solution directory

A directory can be specified here in which the
projects are to be saved by default.

Catalog directory

This specifies the directory in which the catalogs
are saved.
If the catalogs are moved to a different directory,
the directory given here must be changed.

Start application

6.19.3

Here it is possible to specify whether a new project, the most recently opened project or no project is offered for opening when WorkVisual is
started.

Configuring keyboard shortcuts

Procedure

1. Select the menu sequence Extras > Options. The Options window is
opened.
2. In the Environment folder, select the subitem Keyboard.
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3. In the Commands box, select the command for which a keyboard shortcut
is to be defined or changed.
The contents of the Command box can be filtered:
Enter a term in the box List only commands with the following content.
Only commands whose names contain this term are now displayed in the
Command box.
4. Place the cursor in the New shortcut box and confirm the desired key
combination (or individual key) on the keyboard. Examples: F8 or Ctrl+F
The keyboard shortcut is displayed in the New shortcut box.
5. Click on Assign.
6. Confirm the change with OK.
Or: If the keyboard shortcuts are already assigned, a request for confirmation is displayed:


If the keyboard shortcut is to be assigned to the new command, select
Yes and confirm the changes with OK.



If the keyboard shortcut is to remain assigned to the old command, select No.
Close the window by selecting Cancel. Or delete the keyboard shortcut from the New shortcut box using the Esc key, and enter a different
one.

6.19.4

Changing the user interface language

Precondition

To able to select the language Chinese, Japanese or Korean:


Procedure

This language must also be installed as a Windows language.

1. Select the menu sequence Extras > Options. The Options window is
opened.
2. Select the Localization folder.
3. Select the desired language from the Language box. Click OK to confirm.
4. Close and restart the application.

6.20

Print functions
The procedure described here can be used to print the following:

Procedure



I/O connections



Long texts



Safety configuration

1. Select the menu sequence File > Print. The Print window is opened.
2. Select the desired printer in the Printer area. If required, change the printer settings.
3. In the Document area, select the relevant checkboxes to indicate what
should be printed.
4. If required, first display the print preview: To do this, click on the Preview
button.
Close the print preview again.
5. Click on the Print button to start printing.
It is also possible to print directly from the print preview, via the button with the
printer symbol. In this case, the standard printer is used. Changes to the printer settings are not possible.

Description
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Check box

Description

Global

This function is not yet assigned.

Cell

If this checkbox is activated, all the robot controllers belonging to this cell are automatically activated. Individual controllers can be deactivated
again manually.

Controller […]

If this checkbox is activated, all the documents
belonging to this robot controller are automatically selected for printing. Individual documents
can be deactivated again manually.

Documents:
Connection list

Prints the I/O connections defined in the I/O
Mappings window.

Long texts

If long texts have been defined in various languages, it is also possible to select which languages should be printed.

Safety configuration

The printout contains a date and signature box
and can be used as a sign-off sheet for the
safety acceptance procedure.
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7

Safety configuration

7.1

Safety configuration in WorkVisual
The safety configuration in WorkVisual comprises the following areas:
Area

Description

Local safety configuration

The local safety configuration comprises the
parameters in the Local safety configuration
window. The parameters can be edited.
(>>> 7.2 "Editing the local safety configuration"
Page 39)

Safety-relevant communication parameters

These include the parameters relevant to safe
communication within a robot network.
The safety-relevant communication parameters
cannot be displayed or edited directly. However,
various actions in WorkVisual have an effect on
the safety-relevant communication parameters,
e.g. if a RoboTeam is configured.

When a project is transferred to the real robot controller, the entire safety configuration is always transferred at the same time.

7.2

Editing the local safety configuration

Description

A newly added robot controller is without a local safety configuration in
WorkVisual. A robot controller without a local safety configuration can be recognized by the fact that the text of the Safety controller node on the Hardware tab in the Project structure window is in italics: Safety controller
The robot controller is automatically assigned a local safety configuration in
WorkVisual when the Local safety configuration window is opened.
The local safety configuration can be edited in WorkVisual. The changes always apply to the robot controller which is currently set as active.

Precondition



A robot controller has been added and set as active.



If the robot controller has not yet been assigned a local safety configuration: A robot has been assigned to the robot controller.
(>>> 6.16 "Assigning a robot to the robot controller" Page 28)

Procedure

1. Select the menu sequence Editors > Safety configuration (local). The
Local safety configuration window is opened.
2. If this has not already been done:
In the Overview area of the General tab, select the safety option used:
SafeOperation, SafeRangeMonitoring, or none.
3. If SafeOperation or SafeRangeMonitoring is used: Activate the Safe monitoring checkbox in the Global parameters area of the Common tab.
(Only then are the monitoring functions displayed and can be edited.)
4. Modify the parameters as required.
5. Close the Local safety configuration window.
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Some parameters of the local safety configuration are always displayed.
Parameters referring to SafeOperation or SafeRangeMonitoring are
only displayed if one of these options is selected on the General tab. Information on these parameters can be found in the documentation for KUKA.SafeOperation and KUKA.SafeRangeMonitoring.

7.3

“General” tab

Hardware options

Parameter

Description

Customer interface

Select here which interface is used:


ProfiSafe



SIB



SIB, Extended SIB



SIB with operating mode output



SIB with operating mode output, Extended SIB
This option is available with System Software
version 8.2.4 or higher.

Input signal for peripheral contactor (US2)

Main contactor 2 can be used as a peripheral
contactor, i.e. as a switching element for the
power supply to peripheral devices.
Deactivated: Peripheral contactor is not used
(default).
By external PLC: The peripheral contactor is
switched by an external PLC via input US2.
By KRC: The peripheral contactor is switched in
accordance with the motion enable. If motion
enable is present, the contactor is energized.

Operator safety
acknowledgement

If the Operator Safety signal is lost and reset in
Automatic mode, it must be acknowledged
before operation can be continued.
By acknowledgement button: Acknowledgement is given e.g. by an acknowledgement button (situated outside the cell). Acknowledgement
is communicated to the safety controller. The
safety controller re-enables automatic operation
only after acknowledgement.
External unit: Acknowledgement is given by the
system PLC.

Change log

Every modification to the local safety configuration and every saving operation
are automatically logged. The log is displayed here.

Machine data

The machine data of the safety controller are displayed here.
(>>> 7.4 "Importing machine data into the local safety configuration" Page 40)

7.4

Importing machine data into the local safety configuration

Description

In the following cases it is possible to import machine data into the local safety
configuration:
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Or if machine data files exist in the project (e.g. if the project has been
transferred from a real robot controller to WorkVisual).

This import is necessary, e.g. if an external axis has been added to the project
and settings are to be made for it in the safety configuration. The corresponding parameters are only displayed in the safety configuration after the import.
If the machine data are imported into the local safety
configuration in WorkVisual, it is still imperative to check
the local safety configuration again on the real robot controller after the project has been transferred.
(>>> 13.6 "Checking the safety configuration of the robot controller"
Page 110)
Precondition

Procedure



The robot controller has been set as the active controller.



A robot has been assigned to the robot controller.

1. Select the menu sequence Editors > Safety configuration (local). The
Local safety configuration window is opened.
2. Select the General tab and then the Machine data option.
3. Click on the Import machine data button.
4. If the machine data were imported successfully, this is indicated by a message in the message window.
5. Close the Local safety configuration window.

7.5

Importing a local safety configuration
After importing a safety configuration or parts thereof, the
safety configuration must be checked! If this is not done,
this can lead to the possibility of the robot being operated with incorrect data
when the project is transferred to the real robot controller. Death to persons,
severe physical injuries or considerable damage to property may result.
The robot controller has been set as the active controller.

Precondition



Procedure

1. Select the menu sequence File > Import / Export. The Import/Export
Wizard window is opened.
2. Select Import local safety configuration and click on Next.
3. Navigate to the path where the SCG file is located and select it. Click on
Open.
4. Click on Finish.
5. If the configuration was imported successfully, this is indicated by a message. Close the Import/Export Wizard window.

7.6

Exporting a local safety configuration

Description

The local safety configuration is exported as an SCG file.

Precondition



Procedure

1. Select the menu sequence File > Import / Export. The Import/Export
Wizard window is opened.

The robot controller has been set as the active controller.

2. Select Export local safety configuration and click on Next.
3. Specify a directory and a file name. Click on Finish.
4. If the configuration was exported successfully, this is indicated by a message. Close the Import/Export Wizard window.
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7.7

Importing safety zones
After importing a safety configuration or parts thereof, the
safety configuration must be checked! If this is not done,
this can lead to the possibility of the robot being operated with incorrect data
when the project is transferred to the real robot controller. Death to persons,
severe physical injuries or considerable damage to property may result.

Description

Certain parts of the local safety configuration can be imported as an XML file.
These parts are referred to here as “Safety zones” and comprise:


Cell configuration



Monitoring spaces (Cartesian spaces and/or axis spaces)



Properties of the tools

The XML file can be created by the user on the basis of data from CAD systems, etc. The required structure of the XML file is described in the schema
SafetyConfigImport.xsd. This is located in the following directory:
C:\Program Files\KUKA\WorkVisual [version number]\Schemes
Precondition

Procedure



The robot controller has been set as the active controller.



In the safety configuration, one of the following options is selected in the
Overview area of the General tab: SafeOperation or SafeRangeMonitoring

1. Save the project. (Do not close.)
2. Select the menu sequence File > Import / Export. A window opens.
3. Select the entry Import local safety configuration. The window is now
called SafetyConfigImport.
Click on Next.
4. Click on Search…. Navigate to the path where the XML file is located and
select it. Click on Open.
If the XML file contains schema errors, this is indicated by a message in
the SafetyConfigImport window. (The data can still be imported.)
5. If required: Activate the check box Show differences.
If this option is activated, the differences between the existing values and
those to be imported are displayed before the import is carried out.
6. Click on Finish. In the background, the window Local safety configuration is opened, if not already open.
If Show differences is not activated: the data are now imported.
7. If Show differences is activated: the overview is displayed. (>>> Fig. 7-1 )
Click on Import. The data are now imported.
8. When the import is finished, this is indicated by the following message:
The local safety configuration was imported successfully. This message is also displayed if errors were imported.
Close the SafetyConfigImport window.
If errors were imported, this is indicated by messages in the message
window.
9. Check the safety configuration. The data are displayed in the Local safety
configuration window in the following colors:
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Red: This value was changed by the import. The value is invalid.



Blue: This value was changed by the import. The value is valid.
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Blue does not automatically mean that this is the value from the XML
file! It is possible, for example, that the XML file contained a value
which cannot be interpreted by WorkVisual, e.g. “2” where only “0” or
“1” is possible. In this case, WorkVisual sets the default value and displays
this in blue.
10. Correct the invalid values. (If invalid values are present, the project cannot
be saved.)
11. Save the project to accept the imported data.
The imported data are only accepted when the project is saved.
This also means that imported data can be discarded by closing the
project without saving.
Show differences

Fig. 7-1: Example: Displaying the differences
Color

Meaning

Red

With this element (or its child elements), the existing value differs from the value to be imported.

Black

With this element (including all its child elements), the existing
value is identical to the value to be imported.
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8

Bus configuration

8.1

Configuring the bus

8.1.1

Overview: Bus configuration
Step

Description

1

Install the device description files on the PC.

2

Insert the DTM Catalog in the Catalogs window.

(>>> 6.8 "Importing device description files" Page 25)
(>>> 6.10 "Inserting a catalog in a project" Page 26)
3

Insert the field bus master in the project.
(>>> 8.1.2 "Inserting a field bus master in a project" Page 45)

4

Configure the field bus master.
(>>> 8.1.3 "Configuring the field bus master" Page 46)

5

Add the devices to the bus, i.e. insert them under the field bus
master.
(>>> 8.1.4 "Inserting devices manually into the bus" Page 46)
Or:
(>>> 8.1.7 "Automatically inserting devices into the bus (Bus
Scan)" Page 49)

6

Configure the devices.
(>>> 8.1.5 "Configuring devices" Page 46)
Or (only possible for PROFINET):
(>>> 8.1.6 "Importing a PROFINET configuration" Page 47)

7

Edit the field bus signals
(>>> 8.2 "Editing field bus signals" Page 50)

8

The bus I/Os can now be mapped.
(>>> 8.3 "Mapping the bus I/Os" Page 55)

8.1.2

Inserting a field bus master in a project

Precondition

Procedure



The device description files are inserted in the DTM Catalog (Catalog
Scan).



The robot controller has been added and set as active.

1. Expand the tree structure on the Hardware tab in the Project structure
window until the Bus structure node is visible.
2. Right-click on Bus structure and select Add from the context menu. The
DTM selection window is opened.
3. Select the required field bus master and confirm with OK. It is inserted in
the tree structure.

Alternative
procedure

1. Expand the tree structure on the Hardware tab in the Project structure
window until the Bus structure node is visible.
2. Select the required field bus master in the DTM Catalog window and drag
it onto the Bus structure node.
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8.1.3

Configuring the field bus master

Precondition

Procedure



The field bus master is inserted in the project.



The robot controller has been set as the active controller.

1. Right-click on the field bus master on the Hardware tab in the Project
structure window.
2. Select Settings… from the context menu. A window opens with device data.
3. Set the data as required and save with OK.
The following address ranges are used by default by the
robot controller for internal purposes. IP addresses from
this range must not therefore be assigned by the user.


192.168.0.0 … 192.168.0.255



172.16.0.0 … 172.16.255.255



172.17.0.0 … 172.17.255.255
Information about settings for particular bus systems can be found in
the documentation for these bus systems.

8.1.4

Inserting devices manually into the bus
The inserted device must correspond to the actual device used in reality. Substantial damage to property may
otherwise result.

Precondition

Procedure



The devices are inserted in the DTM Catalog.



The field bus master is inserted in the bus structure.



The robot controller has been set as the active controller.

1. Expand the tree structure on the Hardware tab in the Project structure
window until the field bus master is visible.
2. Right-click on the field bus master and select Add… from the context
menu. The DTM selection window is opened.
3. Select the desired device and confirm with OK. The device is inserted in
the tree structure.
4. If necessary, repeat steps 2 and 3 for further devices.

Alternative
procedure

1. Expand the tree structure on the Hardware tab in the Project structure
window until the field bus master is visible.
2. Select the required device in the DTM Catalog and drag it onto the field
bus master.
3. If necessary, repeat step 2 for further devices.

8.1.5

Configuring devices

Precondition

Procedure



The device has been added to the bus.



The robot controller has been set as the active controller.

1. Right-click on the device on the Hardware tab in the Project structure
window.
2. Select Settings… from the context menu. A window with the device data
is opened.
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3. Set the data as required and save with OK.
The following address ranges are used by default by the
robot controller for internal purposes. IP addresses from
this range must not therefore be assigned by the user.


192.168.0.0 … 192.168.0.255



172.16.0.0 … 172.16.255.255



172.17.0.0 … 172.17.255.255
Information about settings for particular bus systems can be found in
the documentation for these bus systems.

8.1.6

Importing a PROFINET configuration

Description

A PROFINET bus can also be configured with Step 7 or PC WORX instead of
with WorkVisual. This configuration must then be imported into WorkVisual.

Preparation

WorkVisual requires the GSDML files of the PROFINET devices used. (The
device description files for PROFINET are called GSDML files.)


Import the files.
(>>> 6.8 "Importing device description files" Page 25)

Precondition



The robot controller has been set as the active controller.



The PROFINET configuration has been exported out of Step 7 or PC
WORX and is available as an XML or CFG file.

Information about configuring PROFINET with Step 7 or PC WORX
can be found in the documentation KR C4 PROFINET. Information
about procedures in Step 7 or PC WORX can be found in the documentation for this software.
Procedure

1. Select the menu sequence File > Import / Export. The Import/Export
Wizard window is opened.
2. Select Import Profinet configuration and click on Next.
3. Click on the Browse… button and navigate to the path where the XML or
CFG file is located and select it. Click on Open.
4. Click on Next.
5. A tree structure is displayed. This shows whether the PROFINET configuration corresponds to the devices in the project. If not, the difference is displayed. If necessary, the import can be canceled at this point with Cancel.
(>>> 8.1.6.1 "Differences between the PROFINET configuration and the
project" Page 47)
Otherwise, click on Finish. This is also possible if the configuration differs
from the devices in the project. If there is a difference:


The PROFINET configuration overwrites the state in the project.



The nature of the difference determines whether the I/O mappings in
the project are retained or not.

6. If the configuration was imported successfully, this is indicated by a message. Close the Import/Export Wizard window.
8.1.6.1

Differences between the PROFINET configuration and the project
If the device is marked with a green check mark, this means that there is no
difference. The device is identical in the PROFINET configuration and in the
project.
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If there are differences, these are displayed during import of the PROFINET
configuration as follows:
Device missing

Difference

The device is contained in the PROFINET configuration but not in the project.

Icon

Green cross

Effect on import

The device is inserted into the bus in the project.

Fig. 8-1: Device not in project
Device too many

Difference

The device is contained in the project but not in the
PROFINET configuration.

Icon

Red X

Effect on import

The device is deleted from the bus in the project.
I/O mappings to this device are also deleted!

Fig. 8-2: Device not in import
IP settings

Difference

The IP settings of this device in the project are different
from those in the PROFINET configuration.
(boxes IP address, subnet mask or standard gateway)

Icon

Pen

Effect on import

The IP settings of the PROFINET configuration are
applied to the project.
The I/O mappings of this device are retained.

Fig. 8-3: IP settings changed in WorkVisual
Module
assignment
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Difference

The module assignment of this device in the project is
different from that in the PROFINET configuration.
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Icon

Double arrow

Effect on import

The module assignment of the PROFINET configuration is applied to the project.
I/O mappings to this device are deleted!

Fig. 8-4: Different module assignment
PROFINET name

Difference

The PROFINET name of this device in the project is
different from that in the PROFINET configuration.
WorkVisual regards the device as 2 different devices.

Icon

Red X and green cross

Effect on import

The device is added to the project from the configuration. The device that was previously in the project is
deleted.
The I/O mappings to this device are also deleted!

Fig. 8-5: Different PROFINET name
In the tree structure, the product name is displayed, not the PROFINET name of the device. That is why the names are the same here.
Text color

The text color is normally black.
Text color

Meaning

Orange

No GSDML file can be clearly assigned to this device.
The relevant possible files are listed in the selection
box. The user must choose a file.

Red

No GSDML file is available in WorkVisual for this
device. The user must make the file available.
(>>> "Preparation" Page 47)

8.1.7

Automatically inserting devices into the bus (Bus Scan)

Description

The bus scan is available for Interbus and EtherCAT.
The bus devices can be inserted automatically. For this, the user can start a
scan in WorkVisual to determine which devices are connected to the real bus.
The corresponding devices are then inserted automatically into the bus structure in WorkVisual.
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In contrast to manual insertion, this procedure is faster and less susceptible to
error.
Precondition



The devices are inserted in the DTM Catalog.



The field bus master is inserted in the bus structure.



The robot controller has been set as the active controller.



Network connection to the real robot controller



The devices are connected to the real robot controller.
There are further preconditions depending on the bus system used.
Information about this is contained in the documentation for the different bus systems.

Procedure

1. Expand the tree structure of the robot controller on the Hardware tab in
the Project structure window.
2. Right-click on the field bus master. Select the option Scan Topology…
and then select a channel. The Topology Scan Wizard window is
opened.
3. Click on Continue to start the scan. When the scan is completed, WorkVisual displays all the devices found in the window on the left. Each device
is represented by a number (= product code).
4. Select a device. In the window on the right, WorkVisual displays a list of
the device description files which have the same product code.
5. If the list contains a number of device description files, scroll down the list
and check if the file of the device that is actually used is selected. If a different file is marked, select the option Manual selection and select the
correct file.
6. Repeat steps 4 and 5 for all devices shown.
7. Click on Continue to confirm the assignment.
8. Click on Finish to assign the devices to the field bus master.

8.2

Editing field bus signals

Description

Field bus signals can be edited in WorkVisual. For example, the signal width
can be changed or the byte order can be swapped.

Precondition



Procedure

1. Select the device on the Field buses tab in the I/O Mapping window.

The field bus devices are configured.

2. In the I/O Mapping window, click on the Edit signals at the provider button. The Signal Editor window is opened. All inputs and outputs of the device are displayed.
(>>> 8.2.1 "Signal Editor" Page 50)
3. Edit the signals as required.
4. Click on OK to save the changes and close the Signal Editor window.
8.2.1

Signal Editor
In the Signal Editor, the inputs of the selected device are displayed on the left
and the outputs on the right.
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Fig. 8-6: Signal Editor
Item

Description

1

The left-hand column displays the original configuration of the inputs or outputs. Each box represents 1 bit.

2

The right-hand column can be edited and always displays the current configuration of the inputs or outputs. Each box represents 1
bit.

3

Signal name

4

Start mark for swapping

(>>> 8.2.5 "Changing signal names" Page 54)
(>>> 8.2.3 "Swapping signals (reversing the byte order)" Page 52)
5

Address at which this signal starts

6

Signal width
(>>> 8.2.2 "Changing the bit width of signals" Page 52)

7

Address to which this bit belongs, and number of the bit

8

The bar indicates that the byte order has been swapped.

9

Boundary between memory segments

10

Data type of this signal
(>>> 8.2.4 "Changing the data type" Page 54)
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8.2.2

Changing the bit width of signals

Description

This procedure can be used to change the width of signals. Signals can be
split or grouped. It is also possible to split signals more than once.
The signal boundaries can be moved only as far as the boundaries of the
memory segments. Signal boundaries cannot be moved beyond the boundaries of swapped ranges.
Bits that are being edited are indicated in red.

Precondition

Procedure



The Signal Editor is open.



The signals that are to be edited are not mapped.

Moving a signal boundary:
1. In the right-hand column, position the mouse pointer over the boundary
line between 2 signals. The mouse pointer changes into a vertical double
arrow.
2. Click and hold down the mouse button and move the mouse pointer up or
down. The boundary line is moved.
3. Drag the boundary line to the desired position and let go.
This procedure can be used to reduce a signal down to the size of 1 bit.
Splitting a signal:
1. In the right-hand column, position the mouse pointer over a bit.
2. Click and hold down the mouse button and move the mouse pointer up or
down. A line is displayed over the output bit.
3. Drag the mouse pointer to another bit and let go. A line is also displayed
over this bit. The two lines are the boundaries of the new signal.
Grouping signals:
1. In the right-hand column, position the mouse pointer over the first (or last)
bit of a signal.
2. Click and hold down the mouse button and move the mouse pointer down
(or up).
3. Drag the mouse pointer across a signal boundary to another signal boundary and let go. The intervening signal boundary disappears. The signals
have been grouped.

8.2.3

Swapping signals (reversing the byte order)

Description

The byte order of signals can be swapped. It is possible to swap 2, 4 or 8 bytes
at once. Sub-ranges of signals cannot be swapped. Furthermore, it is not possible to swap across the boundaries of memory segments.
The bits within a byte always remain unchanged.
The (V)KR C4 robot controller uses the Intel data format. Field bus
signals in Motorola format must be converted to Intel. This is done by
means of swapping.
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It is not always clear from the manufacturer’s data sheets whether a
signal needs to be swapped or not. The signals of Siemens devices
generally need to be swapped. The following procedure can provide
information about whether it is necessary to swap an input:
1. Change the voltage on the input slowly and evenly.
2. Observe the values for this signal in the Analog I/O window on the KUKA.smartHMI.
If the values change abruptly and unevenly or in different directions, this is
an indication that swapping is necessary.
It makes a difference whether a range is swapped as a whole or in parts:

Fig. 8-7: Example 1: Swapping the byte order
Item

Description

1

Original order

2

Result of swapping the bytes in two groups (i.e. the first two bytes
are swapped and the second two bytes are swapped separately.)

Fig. 8-8: Example 2: Swapping the byte order
Item

Description

1

Original order

2

Result of swapping all the bytes at once

The Signal Editor is open.

Precondition



Procedure

1. Position the mouse pointer over a start mark for swapping. The mouse
pointer changes into a vertical double arrow.
2. Click and hold down the mouse button. Move the mouse pointer downwards to the signal boundary.
3. A bar is displayed.


Either: Release the mouse button. The byte order has now been
swapped.



Or: If a larger range is to be swapped, keep moving the mouse pointer
without letting go. A longer bar is displayed. Release the mouse button. The byte order has now been swapped.

An end mark for swapping is displayed.
To undo the swapping:
1. Position the mouse pointer over an end mark for swapping. The mouse
pointer changes into a vertical double arrow.
2. Click and hold down the mouse button. Move the mouse pointer up towards the start mark.
3. The bar disappears. The swapping has been undone.
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8.2.4

Changing the data type

Description

In the Signal Editor, the data type is displayed by an icon.
Icon

Description
Integer data type with sign (depending on the length:
SINT, INT, LINT or DINT)
Integer data type without sign (depending on the
length: USINT, UINT, ULINT or UDINT)
Digital data type (depending on the length: BYTE,
WORD, DWORD or LWORD)

(The exact data type of a signal is displayed in the I/O Mapping window.)
The data type must changed e.g. if a signal needs to be used as an analog
output or input but is only designated as a digital data type in the device description file.
The Signal Editor is open.

Precondition



Procedure

1. Click on the icon for the sign on the right-hand side of the input or output
column. The icon changes.
2. Click until the desired symbol is displayed.

8.2.5

Changing signal names
The Signal Editor is open.

Precondition



Procedure

1. Click on the name of the input or output in the right-hand column. The
name can now be edited.
2. Enter the desired name and confirm with the Enter key.
The name must be unambiguous within the current view of the Signal Editor.
The changed name is displayed in the I/O Mapping window.
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8.3

Mapping the bus I/Os

8.3.1

I/O Mapping window

Overview

Fig. 8-9: I/O Mapping window
Item
1

Description
Display of the input/output types and field bus devices. The two areas to be connected are selected on the left and right via tabs.
The signals in the areas selected here are displayed in the windows lower down.

2

Display of the mapped signals

3

Display of all signals. The inputs/outputs can be mapped here.
(>>> 8.3.3 "Mapping input to output" Page 57)

4

This allows the two signal displays to be collapsed and expanded
independently of one another.

5

Displays how many bits the selected signals contain

Mapped signals are indicated by green symbols.
Multiply mapped signals are indicated by double arrows:
(>>> 8.3.2 "Buttons in the I/O Mapping window" Page 56)
Tabs:
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8.3.2

Name

Description

KR C I/Os

Here the analog and digital inputs/outputs of the robot
controller are displayed. There is a KR C I/Os tab on
the left and on the right. This makes it possible to map
inputs and outputs of the robot controller with each
other.

PLC

These tabs are only relevant if Multiprog is used.

KR C signals

Here the other signals of the robot controller are displayed.

Field buses

Here the inputs/outputs of the field bus devices are displayed.

Buttons in the I/O Mapping window

Filter/ Search

Some of these buttons are displayed in several places. In such cases, they refer to the side of the I/O Mapping window on which they are located.
With some buttons, the tool tip changes depending on whether the signals
they refer to are shown or hidden.
Button

Name / description
Filter inputs/Display all inputs: Shows and hides the inputs.
Filter outputs/Display all outputs: Shows and hides the outputs.
Filter dialog: The Filter signals window is opened. Enter filter criteria (name, data type and/or signal range) and click on
the Filter button. Signals that conform to these criteria are
displayed.
When a filter is set, the button displays a green check mark at
bottom right. To remove a filter that has been set, click on the
button and, in the Signals window, click on the Reset button
and then on Filter.
Buttons above the “connected signals” window:
Search for the connected signal: Only available if a
mapped signal is selected.
(>>> 8.3.6 "Searching for assigned signals" Page 59)
Button below the “all signals” window:
Search text: Displays a search box. Here it is possible to
search the signal displays for signal names (or parts of
names), either upwards or downwards.
When the search box is displayed, the button displays a cross
at bottom right. To hide the search box again, click on the button.
Filter connected signals/Display all connected signals
Shows and hides the connected signals.
Filter disconnected signals/Display all unconnected signals
Shows and hides the unconnected signals.
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Mapping

Button

Name / description
Disconnect: Disconnects the selected mapped signals. It is
possible to select and disconnect a number of connections
simultaneously.
Connect: Connects signals which are selected in the “all signals” display. It is possible to select a number of signals on
both sides and connect them at one go. (Only possible if the
same number of signals is selected on both sides.)

Edit

Button

Name / description
Creates signals at the provider
Only relevant if Multiprog is used.
Edit signals at the provider
For field bus signals: opens an editor in which the bit assignment of the signals can be edited.
(>>> 8.2 "Editing field bus signals" Page 50)
Editing options are also available here for the analog inputs/
outputs of the KRC and for Multiprog signals.
(>>> 8.3.8 "Editing analog KRC signals" Page 60)
Deletes signals at the provider
Only relevant if Multiprog is used.
Information about Multiprog is contained in the KUKA.PLC Multiprog
documentation.

8.3.3

Mapping input to output

Description

This procedure is used to assign the inputs and outputs of the devices to the
inputs and outputs of the robot controller.
By the same principle, it is also possible to map inputs and outputs of the robot
controller to each other. (In this case, the KR C I/Os tab must be used in both
halves of the window.)

Precondition

Procedure



The robot controller has been set as the active controller.



The bus configuration in WorkVisual corresponds to the real bus configuration.



The field bus devices are configured.

1. Click on the Opens the I/O Mapping Editor button. The I/O Mapping window is opened.
2. On the KR C I/Os tab in the left-hand half of the window, select the area
of the robot controller that is to be mapped, e.g. Digital inputs.
The signals are displayed in the bottom area of the I/O Mapping window.
3. Select the device on the Field buses tab in the right-hand half of the window.
The signals of the device are displayed in the bottom area of the I/O Mapping window.
4. Drag the signal of the robot controller onto the input or output of the device.
(Or alternatively, drag the input or output of the device onto the signal of
the robot controller.)
The signals are now mapped.
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Alternative procedure for mapping:


Select the signals to be mapped and click on the Connect button.



Or: Select the signals to be mapped and select the Connect option from
the context menu.

Multiple mapping:
It is possible to select a number of signals simultaneously (on both sides) and
connect them at one go. A further possibility is as follows:
1. Select a number of signals on one side and one signal on the other side.
2. Select the option Connect continuously from the context menu. The signals are connected (counting upwards), starting from the one selected signal.
8.3.4

Mapping bus input to bus output

Description

A bus input can be mapped to a bus output (in the same or a different bus).
This is done indirectly. A total of 3 mappings are required for this.

Procedure

1. Map the bus input to an input of the robot controller.
2. Map the robot controller input to a robot controller output.
3. Map the robot controller output to a bus output.
The input and output of the robot controller are thus multiply mapped in this
case.

Schematic

Fig. 8-10: Schematic: Mapping bus input to bus output

8.3.5
Possible

Multiple mapping or reverse mapping of signals
Signals can be multiply mapped. Multiply mapped signals are indicated in the
I/O Mapping window by a double arrow:
The following multiple mapping is possible:
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Map an input (robot controller) to an input (bus).



Map the same input (robot controller) to one or more outputs (robot controller).
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Fig. 8-11: Multiple mapping possible

The following reverse mapping is possible:


Map an output (bus) to an input (robot controller).

Fig. 8-12: Reverse mapping possible
Not possible

The following multiple mappings are not possible:


Map an input (robot controller) to several inputs (bus).



Map an output (robot controller) to several outputs (bus).

Fig. 8-13: Multiple mapping not possible

8.3.6

Searching for assigned signals

Procedure

1. Select a mapped signal.
2. In the part of the window in which the signal was selected (left-hand or
right-hand half), click on the button Searches for the connected signal.


If a signal is mapped once: the assigned signal is now highlighted in
the other half of the “all signals” window.



If a signal is multiply mapped: the Search for signal window opens.
All signals connected with the selected signal are shown.
Select a signal and confirm with OK.
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Fig. 8-14: Example: Multiply mapped signal

8.3.7

Grouping signals

Description

8 digital inputs or outputs of the robot controller can be grouped together to a
signal of the data type BYTE. Grouped signals can be recognized by the name
extension #G.

Precondition



Procedure

1. Below the KR C I/Os tab, select 8 consecutive signals and right-click on
them.

The signals that are to be grouped are not mapped.

2. Select Group.
The signals are grouped to a signal of type BYTE. The name with the lowest index number is taken for the new signal.
To undo the grouping:
1. Right-click on a signal with the name extension #G.
2. Select Ungroup.
Example

Fig. 8-15: Group signals

Fig. 8-16: A grouped signal

8.3.8

Editing analog KRC signals

Procedure
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1. Select the analog signal on the left-hand KR C I/Os tab in the I/O Mapping
window.
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It is also possible to select and edit several signals at once: Consecutive
signals can be selected using SHIFT + click. A number of individual signals
can be selected using CTRL + click.
2. At the bottom left of the I/O Mapping window, click on the button Edit signals at the provider. A window opens.
3. Enter the required calibration factor and change the data type if necessary.
4. Click on OK to save the data and close the window.

8.4

Box

Description

Calibration factor

The required calibration factor can be entered here.

Type

Only signals of the same type can be connected. The
data type can be changed here.

Exporting the bus configuration

Description

The bus-specific configuration can be exported in the form of XML files. This
export makes it possible to check the configuration files if required.
If desired, the files can be copied onto the real robot controller. This is not necessary, however, if the project is transferred to the robot controller online.
(>>> 13.4 "Transferring the project to the robot controller" Page 104)
The robot controller has been set as the active controller.

Precondition



Procedure

1. Select the menu sequence File > Import / Export. The Import/Export
Wizard window is opened.
2. Select Export I/O configuration to .XML files and click on Next.
3. Specify a directory. Click on Next.
4. Click on Finish.
5. The configuration is exported to the specifed directory. If the configuration
was successfully completed, this is indicated by a message.
Close the Import/Export Wizard window.
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Long texts

9.1

Displaying / editing long texts
A robot controller has been added and set as active.

Precondition



Procedure

1. Select the menu sequence Editors > Symbol Table Editor.
2. The long texts are sorted thematically. In the left-hand column, select
which long texts are to be displayed, e.g. Digital inputs.
3. In the other columns, select the language or languages that are to be displayed.
4. Edit the long texts, if necessary.

Description

Fig. 9-1: Symbol Table Editor
The long texts of the digital inputs/outputs can also be edited in the I/
O Mapping window via the Edit signals at the provider button.
(>>> 8.3.1 "I/O Mapping window" Page 55)

9.2

Importing long texts

Description

The following file formats can be imported:


.TXT



.CSV
Imported long texts overwrite existing long texts.

A robot controller has been added and set as active.

Precondition



Procedure

1. Select the menu sequence File > Import / Export. The Import/Export
Wizard window is opened.
2. Select Import Symbol Table and click on Next.
3. Select the file to be imported and the language of the contained long texts.
4. If a signal already has a name and the file to be imported does not contain
a name for this signal, the check box Delete existing entries determines
what happens to the existing name.


Activated: The name is deleted.



Not activated The name is retained.
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Fig. 9-2: Importing long texts
5. Click on Finish.
6. If the import was successful, this is indicated by a message in the Import/
Export Wizard window. Click on Close to close the window.

9.3

Exporting long texts

Description

Long texts can be exported in the following file formats:


.TXT



.CSV

Precondition



A robot controller has been added and set as active.

Procedure

1. Select the menu sequence File > Import / Export. The Import/Export
Wizard window is opened.
2. Select Export SymbolTable and click on Next.
3. Specify the path name and format of the file which is to be generated. Also
select the language. Click on Finish.

Fig. 9-3: Exporting long texts
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4. If the export was successful, this is indicated by a message in the Import/
Export Wizard window. Click on Close to close the window.
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10

Configuring the controller bus, extension bus, system bus

10.1

Overview

Description

The system configuration of the industrial robot must be configured using
WorkVisual in the following cases:


Installation of KSS/VSS 8.2
This is the case if a KSS/VSS 8.2 package is installed without KSS/VSS
8.2 already being present (because it has been uninstalled or deleted or
has never been installed).



The hard drive has been exchanged.



A device has been replaced by a device of a different type.



More than one device has been replaced by a device of a different type.



One or more devices have been removed.



One or more devices have been added.
Once the hard drive has been exchanged, the archive of the previous
installation can be loaded (as an alternative to configuration using
WorkVisual).
Information about exchanging devices and about the possible device
combinations is contained in the operating instructions or assembly
instructions for the robot controller.

Procedure

1. Transfer the active project from the robot controller to WorkVisual.
(>>> 13.7 "Transferring a project from the robot controller to WorkVisual"
Page 110)
If settings have already been made in a project in WorkVisual which
are to be transferred subsequently to the robot controller together
with the controller bus configuration etc., then the active project must
be transferred to WorkVisual using a comparison.
(>>> 13.8 "Comparing projects (and accepting differences)" Page 110)
2. Carry out the relevant configuration work.
(>>> 10.3 "Configuring the controller bus" Page 68)
(>>> 10.3.5 "Inserting the wagon driver configuration" Page 72)
(>>> 10.5 "Configuring further buses" Page 73)
3. If KUKA.ServoGun FC is used: Observe additional points.
(>>> 10.4 "Controller bus configuration for KUKA.ServoGun FC"
Page 73)
4. Transfer the project to the robot controller and activate it there.
(>>> 13.4 "Transferring the project to the robot controller" Page 104)

10.2

Importing device description files (EtherCAT ESI)

Description

To be able to use a device in WorkVisual, WorkVisual requires the device description file for this device.
The device description files for the controller bus and the system bus are installed automatically during installation of WorkVisual. They are available in
WorkVisual as soon as a catalog scan has been performed.
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The procedure described here only needs to be carried out if device
description files are obtained separately from KUKA for the controller
bus or system bus.
There is no project open.

Precondition



Procedure

1. Select the menu sequence File > Import / Export. The Import/Export
Wizard window is opened.
2. Select Import device description file and click on Next >.
3. Click on Browse… and navigate to the directory where the files are located. Confirm with Next >.
4. A window opens. In the File type box, select the entry EtherCAT ESI.
5. Select the file to be imported and confirm with Open.
6. Click on Finish.
7. Close the Import/Export Wizard window.

10.3

Configuring the controller bus

10.3.1

Inserting (or removing) devices on the controller bus

Precondition



Only if device description files have been obtained separately from KUKA:
The files have been imported.



The device description files have been inserted in the DTM Catalog.

(>>> 10.2 "Importing device description files (EtherCAT ESI)" Page 67)
(>>> 6.9 "Inserting the field bus master in the DTM Catalog (Catalog
Scan)" Page 26)


Procedure

The robot controller has been set as the active controller.

1. Right-click on the Bus structure node on the Hardware tab in the Project
structure window.
2. Select Add from the context menu. The DTM selection window is opened.
3. Select the entry KUKA Controller Bus and confirm with OK. KUKA Controller Bus is inserted in the tree structure.
4. Right-click on KUKA Controller Bus.
5. Select Add from the context menu. The DTM selection window is opened.
6. Select the device used and confirm with OK. The device is inserted in the
tree structure.
7. If required: Right-click on the device in the tree structure and select Rename from the context menu. Rename the device.
(>>> "Naming convention" Page 69)
The names that the devices have here in the bus structure are the
names used in error messages.
8. Repeat steps 4 and 7 for all devices used in the real bus.
9. If a device needs to be removed from the bus: Right-click on the device
and select Delete from the context menu.
10. Check the device settings and change if necessary.
(>>> 10.3.2 "Checking the device settings" Page 69)
11. Check the device connections and change if necessary.
(>>> 10.3.3 "Connecting devices on the controller bus" Page 70)
12. Only if the changes in the bus affect a KPP, or if the bus has been complete reconfigured: Insert the wagon driver configuration.
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(>>> 10.3.5 "Inserting the wagon driver configuration" Page 72)

Fig. 10-1: Example of a controller bus
Arrange the devices in the KUKA Controller Bus node in the same
order as they are arranged in reality.
The arrangement has no effect on its functionality of the bus, but it is
easier to edit the connections on the Topology tab if the arrangement already corresponds to reality.
Naming
convention

WorkVisual displays the device names that are defined in the device description files. In practice, other names are often used. For this purpose, the devices can be renamed.
In a bus, more than one device of the same type may be present. To distinguish them in the bus structure, WorkVisual automatically appends a number
to the name. It is recommended, however, to give the devices meaningful
names, e.g. by including the abbreviation for the installation position of the devices.
Name in WorkVisual

Usual name

KUKA Controller Bus (KCB)

[identical]

Cabinet Interface Board (CIB)

[identical]

Resolver Digital Converter (RDC)

[identical]

KUKA Power Pack 2 Axes (KPP2)

KUKA Power Pack 2 Axes (KPP2)
(G1)

KUKA Servo Pack (KSP)

KUKA Servo Pack Wrist Axes
(KSP) (T1)
KUKA Servo Pack Main Axes
(KSP) (T2)

KRC4 Electronic measuring tool
(EMD)
10.3.2

Electronic Mastering Device (EMD)

Checking the device settings

Procedure

1. Right-click on the device on the Hardware tab in the Project structure
window.
2. Select Settings… from the context menu. The Settings… window is
opened.
3. Select the General tab.
4. Check that the following settings have been made. If not, correct the settings.


Check vendor ID: active
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Check product code: active



Check revision number: OFF



Check serial number: inactive

5. Close the window by clicking on OK.

Fig. 10-2: Device settings, “General” tab

10.3.3

Connecting devices on the controller bus

Description

If devices are inserted into the controller bus, WorkVisual connects the devices automatically. As WorkVisual does not know the real bus configuration, the
connections must be checked and changed where necessary.
Information about the connector pin allocation of the devices can be
found in the operating instructions for the robot controller.
All the devices used have been inserted into the KUKA Controller Bus
node.

Precondition



Procedure

1. Right-click on the KUKA Controller Bus node on the Hardware tab in the
Project structure window.
2. Select Settings… from the context menu. The Settings… window is
opened.
3. Select the Topology tab.
(>>> 10.3.4 "“Topology” tab" Page 71)
4. Select and delete invalid connections. To do this, either press the Del key,
or right-click and select Delete.
5. Insert missing connections. To do this, click on a connection and hold
down the mouse button. Drag the mouse pointer to another connection
and release the mouse button.
6. Mark temporary connections as such. To do this, right-click on the connection and select Disconnectable from the context menu. The connection is
displayed as a broken line.
A temporary connection is e.g. the connection to the Electronic Mastering
Device (EMD), because the EMD is not permanently connected.
7. Click on devices for which the address or alias address is not yet correct.
A window appears. Enter the correct address.
All temporarily connected devices require an alias address. For the EMD,
the alias address 2001 must be entered!
8. If required: Rearrange the devices using Drag&Drop. This serves to increase the clarity of the Topology tab. It has no effect on the bus.
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9. Click on OK at bottom right.
10.3.4

“Topology” tab

Fig. 10-3: “Topology” tab
Properties of the “Topology” tab:


Each device in the bus is represented by 1 rectangle.



The numbers of the devices specify their physical address.



To display the name of a device:
Move the mouse pointer onto the device. A tool tip is displayed with the
name of the device.
Or alternatively, select the device. The window on the right displays the
properties of this device, e.g. the name.
The devices in the figure:



Device

Name

1001

Cabinet Interface Board (CIB)

1002

Resolver Digital Converter (RDC)

1003

KUKA Power Pack 2 Axes (KPP2) (G1)

1004

KUKA Servo Pack Wrist Axes (KSP) (T1)

1005

KUKA Servo Pack Main Axes (KSP) (T2)

1006

Electronic Mastering Device (EMD)

To display the name of a connection:
Move the mouse pointer onto the connection. A tool tip is displayed with
the name of the connection.



Lines shows the connections between the devices.
Solid lines indicate permanent connections. Broken lines indicate temporary connections.



The devices can be reordered using Drag&Drop. This serves to increase
the clarity of the Topology tab. It has no effect on the bus.
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The window on the right displays the properties of the selected device, e.g.
the address and alias address. Some of the properties can be changed.
All temporarily connected devices require an alias address. For the EMD,
the alias address 2001 must be entered!



The message area below the graphic shows if a device has an invalid address or alias address.

Editing connections:


Select and delete invalid connections.
To do this, either press the Del key, or right-click and select Delete.



Insert missing connections.
To do this, click on a connection and hold down the mouse button. Drag
the mouse pointer to another connection and release the mouse button.



Mark temporary connections as such.
To do this, right-click on the connection and select Disconnectable from
the context menu. A temporary connection is e.g. the connection to the
Electronic Mastering Device (EMD), because the EMD is not permanently
connected.

10.3.5

Inserting the wagon driver configuration

Description

The wagon driver configuration must be inserted into the WorkVisual project
in the following cases:


If the controller bus has been completely reconfigured.



Or if a change has been made to the controller bus which affects a KPP.



If KUKA.ServoGun FC is used.

For this, the following configuration files are required:


CFCoreWaggonDriverConfig.xml



EAWaggonDriverConfig.xml

These files are automatically installed together with WorkVisual. These can be
found in the directory C:\Program Files\KUKA\WorkVisual[…]\WaggonDriverConfigurations. They can be found there in the subdirectory for the relevant
controller bus variant.
Which wagon driver configuration should be used for which controller
bus?

Precondition
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Controller bus with …

Directory

KPP without external axis

KPP 600-20

KPP with 1 external axis

KPP 600-20-1x40 (1x64)

KPP with 2 external axes

KPP 600-20-2x40

KPP with 1 external axis and ServoGun FC
Sensor Box

KPP 600-20-1x40 + SDC

KPP with 2 external axes and ServoGun FC
Sensor Box

KPP 600-20-2x40 + SDC

4-axis palletizer with external axis

4Ax_PA_mit_ZA

4-axis palletizer without external axis

4Ax_PA_ohne_ZA

5-axis palletizer with external axis

5Ax_PA_mit_ZA

5-axis palletizer without external axis

5Ax_PA_ohne_ZA

AGILUS sixx

6Ax_CIBsr_KPPsr_KSP
sr

The robot controller has been set as the active controller.
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Procedure

1. Expand the node of the robot controller on the Files tab in the Project
structure window.
2. Then expand the following subordinate nodes: Config > User > Common
> Mada.
3. Only if there are already wagon driver files in the Mada directory and these
need to be removed:


Right-click on a file and select Delete from the context menu.



Repeat for the second file.

4. Right-click on the Mada folder and select Add external file from the context menu.

Fig. 10-4: Wagon driver configuration
5. A window opens. In the File type box, select the entry All files (*.*).
6. Navigate to the directory in which the files for the wagon driver configuration are located, select the files and confirm with Open.
The files are now displayed in the tree structure below the Mada folder. (If
not: collapse and expand all the folders in order to refresh the display.)

10.4

Controller bus configuration for KUKA.ServoGun FC

SDC topology

10.5

The SDC is connected to connection B of the RDC. The connection is a permanent connection (= not disconnectable).

Configuring further buses
The procedure is analogous to configuring the controller bus. Instead of KUKA
Controller Bus, the following is inserted into the Bus structure node:


KUKA Extension Bus (SYS-X44)



KUKA System Bus (SYS-X48)

Which modules need to be inserted in the KUKA Extension Bus (SYS-X44)
node depends on the specific bus structure in the real robot controller.
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Which modules need to be inserted in the KUKA System Bus (SYS-X48)
node also depends on the real bus structure. There is a maximum of 3 modules, however:
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Module

Must be inserted in which case?

Safety module for Cabinet Interface
Board (SION-CIB)

Must always be inserted.

Safety Interface Board SIB Standard (SION-SIB-STD)

Required if a Standard SIB is
installed in the control cabinet.

Safety Interface Board SIB
Extended (SION-SIB-EXT)

Required if an Extended SIB is
installed in the control cabinet.
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RoboTeam
This documentation describes how RoboTeams can be configured
offline with WorkVisual. Basic information about RobotTeam and
about installation and programming on the robot controller can be
found in the documentation KUKA.RoboTeam.
The “RoboTeam” functionality is not available for projects with VKR
C4 robot controllers.

11.1

Creating a RoboTeam

11.1.1

Creating a new RoboTeam project

Description

WorkVisual provides templates which enable creation of a new project containing one or more RoboTeams. A wizard, the Cell Configuration Wizard,
guides the user through the creation process.

Templates

Templates for projects containing RoboTeams:
Template

Description

Generic project

Creates a project in which the number of
RoboTeams and independent robots is specified
by the user. The user also specifies the number
of robots and external axes in each RoboTeam.

Simple RoboTeam
project

Creates a project with 1 RoboTeam. The
RoboTeam contains 2 robots and 1 external axis.

Project with two
RoboTeams

Creates a project with 2 RoboTeams. Each
RoboTeam contains 2 robots and 1 external axis.
The project also contains a handling robot.

Fig. 11-1: Example screen: Cell Configuration Wizard
Procedure

1. Click on the New… button. The Project Explorer is opened. On the left,
the Create project tab is selected.
2. Select one of the templates for a RoboTeam project in the Available templates area of the tab.
3. Enter a name for the project in the File name box.
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4. The default directory for projects is given in the Location box. If required,
select a different directory.
5. Click on the New button. The Cell Configuration Wizard opens.
6. Make the required settings in the wizard, e.g. select the robot type. Clicking on Next takes you to the next screen.
7. Once all the relevant settings have been made, click on Finish and then,
in the next screen, on Close.
8. The robot network is now displayed on the Hardware tab of the Project
structure window.

Fig. 11-2: Example: RoboTeam on the Hardware tab

11.1.2

Inserting a RoboTeam in an existing project

Description

A RoboTeam can be inserted in an existing project.
If the RoboTeam is to be inserted in a new project, specific templates
are available for project creation. This is quicker and easier than first
creating an ordinary project and then inserting the RoboTeam.
(>>> 11.1.1 "Creating a new RoboTeam project" Page 75)

Precondition

Procedure



The catalogs KukaControllers and KUKARobots[…] are available.



If the RoboTeam is to contain external axes: The catalog KukaExternalAxes is available.

1. Right-click on the node of the cell on the Hardware tab in the Project
structure window and select the option Add RoboTeam from the context
menu.
The node Robot network and the subnode RoboTeam are inserted. The
nodes are numbered by default. They can be renamed.
2. Add the required number of robot controllers to the RoboTeam node.
It must always be the same robot controller that is added.

3. Assign robots to the robot controllers.
4. If required, assign external axes to the robot controllers.
5. If required, a further RoboTeam can be added to the network.
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To do this, right-click on the Robot network node and select the option
Add RoboTeam from the context menu. Then repeat steps 2 to 5.

11.2

Configuring the RoboTeam

11.2.1

Editors for the robot network and RoboTeam
RoboTeams and the associated network are configured using 2 different editors.
At least 1 RoboTeam has been created.

Precondition



Procedure

Open the editor for the robot network:
1. Select the node Robot network on the Hardware tab in the Project
structure window.
2. Double-click on the icon of the node.
Or select the menu sequence Editors > Configure robot network.

Procedure

Open the editor for the RoboTeam:
1. Select the Team node on the Hardware tab in the Project structure window.
2. Double-click on the icon of the node.
Or select the menu sequence Editors > Configure RoboTeam....

Procedure

Rearranging elements in an editor:
The user can move elements to achieve a clear arrangement of the elements.
This has no effect on the configuration of the robot network or RoboTeam.
1. Right-click in the empty space in the editor and select Select elements
from the context menu.
2. Click on an element and hold down the mouse button. The element can
now be moved as desired.

Overview

Context menu

The editors display the following elements and information:
Robot network

RoboTeam

All robot controllers in the network

All kinematic systems in the team
(robots and external axes)

The time master of the network

(Not displayed)

The safety master of each team

(Not displayed)

(Not displayed)

The motion master of the team

(Not displayed)

The workspaces

(Not displayed)

The access rights for the workspaces can be displayed.

The following functions are available in the context menu:
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Icon

Name / description
Select elements
Must be selected in order to move elements or to delete
master/slave links.
Define master/slave link
In the editor for the robot network: Links individual
RoboTeams to form a single safety circuit.
(>>> 11.2.2 "Linking RoboTeams to form a single safety
circuit" Page 78)
In the editor for the RoboTeam: Defines the motion master(s).
(>>> 11.2.4 "Defining the motion master" Page 80)
Delete master/slave link
(>>> 11.2.5 "Deleting a master/slave link" Page 81)
Set time master
Only available in the editor for the robot network. Defines
the time master.
(>>> 11.2.3 "Defining the time master" Page 79)
Open help
Calls the documentation for WorkVisual and displays the
RoboTeam chapter.

11.2.2

Linking RoboTeams to form a single safety circuit

Description

If a robot network comprises more than one RoboTeam, by default the individual teams form separate safety circuits. To group 2 or more teams into a single
safety circuit, a link must be made from the safety master of one team to a robot controller of another team. This robot controller is now the safety master
of the first team.
It is possible to integrate all the teams in a network into a single safety circuit.
The safety masters of the individual RoboTeams are defined automatically by
WorkVisual and cannot be changed. They are indicated by gray arrows in the
editor for the robot network: a gray arrow links each slave with the master.

Precondition

Procedure



The robot network contains more than 1 RoboTeam.



The editor for the robot network is open.

1. Right-click in the empty space in the editor and select Define master/
slave link from the context menu.
2. Click on the safety master of a team and hold down the mouse button.
3. Drag the mouse pointer to the robot controller of another team and release
the mouse button.
The robot controller of the other team is now the safety master of the first
team. This is shown in the editor by a black arrow.
Any previous link with another team is automatically deleted by the new
one.
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Fig. 11-3: Display of safety masters / safety circuits
Item

Description

1

Controller 1 is the safety master of team 1 (cannot be influenced
by the user)

2

With this arrow, the user has linked team 1 and team 2 to form one
safety circuit.
Alternative: an arrow from controller 3 to controller 1

3

11.2.3

Controller 3 is the safety master of team 2 (cannot be influenced
by the user)

Defining the time master

Description

After a robot network has been created, the message window displays which
robot controller has been defined as the time master by WorkVisual. This assignment can be changed.
In the editor for the robot network, the time master is indicated by a small analog clock icon. There can be only 1 time master per network.
On the real robot controller, the time master is not visible and cannot be
changed.
The editor for the robot network is open.

Precondition



Procedure

1. Right-click in the empty space in the editor and select Set time master
from the context menu.
2. Click on the robot controller that is to be set as the new time master.
The new time master is now indicated in the editor by the analog clock
icon. The clock has now disappeared from the previous time master.
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Fig. 11-4: Display of the time master
Item
1
11.2.4

Description
The clock indicates the time master.

Defining the motion master

Description

This procedure is used to define which kinematic system should be able to follow the motions of another kinematic system. The second kinematic system is
then the motion master. This procedure therefore does not define which kinematic systems actually follow the motions of others, but merely which possibilities should apply. Only those kinematic systems that have been defined here
in WorkVisual as master and/or slave can be used as such in the program.
Multiple connections and bidirectional connections are possible, as kinematic
systems may be motion master and slave simultaneously.
Multiple connections between 2 kinematic systems in the same direction are
not possible.
It is advisable to create only those connections which are actually required in the program. Do not connect every kinematic system to every other kinematic system in both directions, as this would take up
TOOL and BASE coordinate systems unnecessarily. These would then be
unavailable for other purposes.
The editor for the RoboTeam is open.

Precondition



Procedure

1. Right-click in the empty space in the editor and select Define master/
slave link from the context menu.
2. Click on a kinematic system (robot or external axis) and hold down the
mouse button.
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3. Drag the mouse pointer to another kinematic system and release the
mouse button.
The first kinematic system can now follow the other kinematic system. This
is shown in the editor by a black arrow.
4. Repeat steps 2 and 3 until every kinematic system is connected to at least
one other kinematic system.
If there are still unconnected kinematic systems, the following error message is displayed on closing the editor: Configuration of Motion Cooperation
for [RoboTeam_name] is not complete!

Fig. 11-5: Display of the motion master
Item

Description

1

KR 60-3 2 is the motion master of KR 60-3 1.

2

KL 250 1 is the motion master of KR 60-3 2. The arrow is orange
instead of black because the mouse pointer is positioned on it.

3

Positioning the mouse pointer on an arrow opens an info box.
Only for projects transferred to WorkVisual from a robot controller:
This displays the translation values of the slave relative to the
WORLD coordinate system of the master.

11.2.5

Deleting a master/slave link

Description

If the link between a safety master and another team is to be changed, the existing link does not need to be deleted separately, as this happens automatically when a new link is established.
Links which define motion masters, however, do have to be deleted if they are
no longer needed.

Procedure

1. Right-click in the empty space in the editor and select Select elements
from the context menu.
2. Click on the arrow to be deleted. The color of the arrow changes to blue.
3. Right-click and select Delete master/slave link from the context menu.
The arrow is deleted.
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11.2.6

Creating and configuring workspaces

Description

The workspaces described here are specific to RoboTeam and have
nothing to do with the following workspaces:
Workspaces configured in the KUKA System Software via Configuration > Extras > Workspace monitoring > Configuration.


Workspaces configured in SafeOperation.

No workspaces can be created or configured for RoboTeam on the real robot
controller.
Precondition

Procedure



The RoboTeam has been created.



The editor for the RoboTeam is open.

1. The editor for the RoboTeam, click on Add in the Definition of the workspaces area.
2. A workspace is inserted. The default name is Semaphor [consecutive no.].
The default name can be changed:
a. Click on the name. The name can now be edited.
b. Change the name and confirm with the Enter key.
3. A robot controller is defined as the workspace master. The workspace
mastesr can be changed:
a. Click on the name displayed next to the Master box.
b. The robot controllers of the team are displayed. Click on the desired
robot controller.
4. To configure the access rights to the workspace, click on the Devices button. A window opens.
5. Define the rights as required. (>>> "Access rights" Page 83)

Workspaces

Fig. 11-6: Display of the workspaces
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Item
1

Description
Display of the workspaces
If there is more than one workspace, the highest workspace (no. 1)
has the highest priority and the lowest workspace has the lowest
priority.

2

The defines whether the status of the workspaces is restored after
a cold start of the robot controller.


Restore Workspaces On: The status is not restored. Clicking
on the button activates the “Restore status” function.



Restore Workspaces Off: The status is restored. Clicking on
the button deactivates the “Restore status” function.

Access rights

Fig. 11-7: Configuring access rights
Item
1

Description
Displays the robot controllers which may not access the workspace.
RIGHT ARROW moves the selected robot controllers into the Devices area.

2

Displays the robot controllers which may access the workspace.
Only 1 robot controller can access a workspace at a time.
Note: The arrangement of the robot controllers in the display does
not reflect the order in which they access the workspace. This order is determined solely by the KRL program.
LEFT ARROW moves the selected robot controllers into the Controllers area.

11.3

Preventing data loss in RoboTeam projects

Description

If changes have been made on the real RoboTeam controllers which have not
been made in WorkVisual (e.g. calibrating tools), these changes are lost if the
RoboTeam project is transferred from WorkVisual to the robot controllers.
If changes are made to a RoboTeam project in WorkVisual without the current
states of the real robot controllers having been updated, data can also be lost
subsequently during transfer.
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Procedure



This data loss can be prevented by transferring the current states of all the
real robot controllers to WorkVisual after opening and before editing a project.
(>>> 13.8 "Comparing projects (and accepting differences)" Page 110)

To reminder the user of this, the following warning message is displayed after
a RoboTeam project is opened: This project contains at least one RoboTeam. To avoid data loss, please carry out a project merge with all involved
controllers.

11.4

Transferring a RoboTeam project to the robot controller

Procedure

The procedure is the same as for ordinary projects.
(>>> 13.4 "Transferring the project to the robot controller" Page 104)
The following must be observed when transferring RoboTeam projects to a robot controller for the first time:


To complete the project, select the active project on the real robot controller.



Completely transfer the state of the real robot controller. For this, activate
the check box for every robot controller in the Selected value column.

When activating a project on the KUKA smartHMI, an
overview is displayed of the changes which will be made
in comparison to the project that is still active on the robot controller.
If changes are listed in the overview under the heading Safety-relevant
communication parameters, this means that the behavior of the Emergency Stop and “Operator safety” signal may have changed compared with the
previous project.
After activation of the project, the Emergency Stop and the “Operator safety”
signal must be checked for safe functioning. If the project is activated on several robot controllers, this check must be carried out for every robot controller. Failure to carry out this check may result in death to persons, severe
physical injuries or considerable damage to property.
Example:
Complete

In this example, a RoboTeam project containing 2 robot controllers is completed. The check box has been activated for both robot controllers in the Selected value column. The check boxes for the subordinate elements are activated
automatically.

Fig. 11-8: Example: Completely transferring the state of the real robot
controller
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Item

Description

1

Check mark for robot controller 1

2

Check mark for robot controller 2
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12

Programming

12.1

Creating a program

Precondition

Procedure



With use of a KR C4 controller: the KRL Templates catalog has been inserted in the Catalogs window.



With use of a VKR C4 controller: the VW Templates catalog has been inserted in the Catalogs window.

1. Expand the tree structure of the robot controller on the Files tab in the
Project structure window.
2. Right-click on the node in which the program is to be created and select
Add… from the context menu. The catalog KRL Templates or VW Templates is opened.
3. Select the desired template and confirm with Add. The program file is inserted in the tree structure.
The file can now be edited with the KRL Editor.

Alternative
procedure

1. Expand the tree structure of the robot controller on the Files tab in the
Project structure window.
2. Select the required template in the KRL Templates or VW Templates catalog and drag it onto a node in the tree structure. The program file is inserted in the tree structure.
The file can now be edited with the KRL Editor.

12.2

Importing a program

Description

Files in the formats SRC, DAT, SUB and KRL can be imported.

Procedure

1. Expand the tree structure of the robot controller on the Files tab in the
Project structure window.
2. Right-click on the node in which the program is to be created and select
Add external file from the context menu.
3. Navigate to the directory where the file is located that is to be imported.
4. Select the file and confirm with Open. The file is inserted in the tree structure.
The file can now be edited with the KRL Editor.

12.3

Displaying the variable declarations in a file
All the KRL variables that are declared in a particular file can be displayed in
a list overview. With SRC files, the variables from the corresponding DAT file
are always displayed at the same time, and vice versa.

Procedure

1. Only if the Variable list window is not yet displayed: Display it by selecting
the menu sequence Window > Variable list.
2. In the Variable list window, set the required update behavior using the
buttons. (Update via the Files tab and/or via the KRL Editor.)
3. Press the Refresh button.
This step can be skipped if no changes have been made since WorkVisual
was last opened or since Refresh was last carried out on the Files tab.
4. Select the file on the Files tab in the Project structure window.
Or: Open the file in the KRL Editor, or, if it is already open, click on the tab
for the file.
5. The variable list now displays all the variables that are declared in this file.
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6. If necessary, a variable can be selected in the KRL Editor as follows (if the
KRL Editor is not yet open, this causes it to open):


Double-click on the line in the search results.



Or: Right-click on the line and select Go to… from the context menu.



Or: Select the line and press the Enter key.

A search function is available in the Variable list window, which allows a
search to be carried out within the current file:


Enter the variable name or part of the name in the search box. The search
results are displayed immediately.

If the cursor is positioned in the Variable list window, CTRL+F can be used to
jump to the search box.
If the cursor is positioned in the search box, this can be emptied by pressing
ESC.
If the search box contains a search term, this remains valid if the focus is moved to another file. It is only possible to display all the variables in a file if the search box is empty.
Description

Fig. 12-1: “Variable list” window
Clicking on a column sorts the list by this column.
Button

Description
Refresh
All the files on the Files tab in the Project structure window
are refreshed. Globally valid variables and references
between the files are updated.
Button is pressed: If a file is selected on the Files tab in the
Project structure window, the variable list is updated.
Button is not pressed: If a file is selected on the Files tab, the
variable list does not change.
Button is pressed: The variable list is updated if the tab of a
file is selected in the KRL Editor.
Button is not pressed: If the tab of a file is selected in the KRL
Editor, the variable list does not change.
Button is pressed: The display is sorted by file type. (Within
this sort mode, it is also possible to sort by column.)
Button is not pressed: The display is not sorted by file type.
Button is pressed: The search includes all global variables.
Button is not pressed: The search refers to all local variables
of the current file.
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12.4

KRL Editor

12.4.1

Opening a file in the KRL Editor

Precondition



This is a file format that can be edited with the KRL Editor.
(>>> "File formats" Page 89)

Procedure

1. Double-click on a file on the Files tab in the Project structure window.
Or: Select the file and select the menu sequence Editors > KRL Editor.
2. To close the file: Click on the “X” at top right.
The KRL Editor allows more than one file to be open simultaneously. If required, they can be displayed side by side or one above the other. This provides a convenient way of comparing contents, for example.
To display the files side by side:
1. Right-click in the title bar of the file in the KRL Editor. Select New Vertical
Tab Group from the context menu.
2. To display the files one behind the other again: Right-click in the title bar
of a file in the KRL Editor. Select Move Next or Move Previous from the
context menu.
To display the files one above the other:
1. Right-click in the title bar of the file in the KRL Editor. Select New Horizontal Tab Group from the context menu.
2. To display the files one behind the other again: Right-click in the title bar
of a file in the KRL Editor. Select Move Next or Move Previous from the
context menu.

File formats

The KRL Editor is used primarily to edit files containing KRL code:


SRC



DAT



SUB

In addition, the KRL Editor can be used to edit the following file formats:


ADD



BAT



CONFIG



CMD



DEL



INI



KFD



KXR



LOG



REG



TXT



XML

Issued: 29.03.2012 Version: KST WorkVisual 2.4 V3 en

89 / 141

WorkVisual 2.4

12.4.2

KRL Editor user interface

Fig. 12-2: KRL Editor user interface
Item
1

Description
Program area
The code is entered and edited here. The KRL Editor provides numerous functions to support the programmer with this.

2

List of the subprograms in this file
To go to a subprogram, select it from the list: the cursor then jumps
to the DEF line of this subprogram.

3

List of variable declarations
This list always refers to the subprogram that is currently selected
in the list of subprograms. To go to a declaration, select the variable from the list: the cursor then jumps to the line containing the
declaration of these variables.

4

Analysis bar
The marks indicate errors or discrepancies in the code.


Hovering with the mouse over a mark displays a tool tip with a
description of the error.



Clicking on the mark makes the cursor jump to the relevant
place in the program. An automatic correction is offered for
some errors/discrepancies.
(>>> 12.4.8 "Quickfix correction" Page 94)

5

The square has the color of the most serious error currently present.
If there are no errors/discrepancies, the square is green.

12.4.3

Zooming in/out

Procedure
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2. Hold down the CTRL key and move the mouse wheel.

12.4.4



Mouse wheel up: zoom in



Mouse wheel up: zoom out

Configuring the KRL Editor

Preparation

Only necessary if it is desirable to see a preview of the effect of the settings:
1. Open a file in the KRL Editor.
2. To see a preview of the colors for the marks: select any point in the file.
(Nothing can be selected in the file while the Options window is open.)

Procedure

1. Select the menu sequence Extras > Options. The Options window is
opened.
2. If no subitems are visible under the Text editor folder, double-click on the
folder to reveal these.
3. Select a subitem. The configuration options for this subitem are displayed
in the right-hand section of the window.
If the mouse pointer is moved over a field, a description is displayed
for this field at the bottom of the window.
4. Make the desired changes.
The changes can be seen immediately if a file is currently open in the KRL
Editor (e.g. if spaces are revealed or hidden).
5. Click on OK to confirm. The changes are saved.
Or discard the changes with Cancel.
The color settings can be reset to the default settings at any time. The Reset
button for this is situated on the corresponding page in the Options window.
(At the bottom of the page; scrolling is required.)

12.4.5

Edit functions

12.4.5.1 General edit functions
Select



Selecting an area: click where the selection should begin and hold down
the left-hand mouse button. Drag the mouse until the desired area is selected, and then release the mouse button.
If the ALT key is additionally held down during selection, it is possible
to select a rectangular area.



Edit

To select a line: click on the line number.

Standard edit functions can be called via the context menu. These include:


Cut, Paste, Copy, Delete



Undo, Redo



Find …

In addition, the following commands are available in the context menu.
Not

all commands are available for every file format.

Commands

which refer to a selected area affect the whole file if no
area is selected.
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Menu item

Description

Edit > Make upper case

Converts all the lower-case letters in the selected string into
upper-case letters.

Edit > Make lower case

Converts all the upper-case letters in the selected string
into lower-case letters.

Edit > Title case

Converts all the initial letters in the selected string into
upper-case letters.

Edit > Convert tabs into spaces

Replaces the tabs in the selected string with spaces.
Note: The number of spaces corresponding to one tab can
be configured in the parameter Indent size.

Edit > Convert spaces into tabs

Replaces the spaces in the selected string with tabs.

Edit > Indent

Inserts additional spaces at the beginning of every line in
the selected area.
Note: The number of spaces inserted can be configured in
the parameter Indent size.

Edit > Remove leading
whitespace

Removes all the leading spaces from the lines in the
selected area.

Folds > Expand all

Opens all folds in the currently displayed file.

Folds > Collapse all

Closes all folds in the currently displayed file.

Format

Indentations, line breaks, etc., are adapted throughout the
file to conform to the standard. The applicable standard
depends on the file format.

Comment selection

Uncomments the line.

Uncomment selection

Comments the line out.

Rename

(>>> 12.4.5.2 "Renaming variables" Page 92)

Go to declaration

(>>> 12.4.7 "Jumping to the declaration of a variable"
Page 94)

Insert snippet

(>>> 12.4.5.4 "Snippets – Fast entry of KRL instructions"
Page 93)

12.4.5.2 Renaming variables
Description

A variable name can be changed in a single action at all points where it occurs.
This is also possible if the variable is declared in a DAT file and used in various
SRC files.

Procedure

1. Select the desired variable at any point.
2. Press F11.
Or: Right-click and select Rename from the context menu.
3. A window opens. Change the name and confirm with OK.

12.4.5.3 Auto-complete
An auto-complete function is available in the KRL Editor.
When entering code, a list containing the following elements is displayed automatically:
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KRL keywords



Known variable names



Known function names



Known user-specific data types (STRUC or ENUM)
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Snippets (>>> 12.4.5.4 "Snippets – Fast entry of KRL instructions"
Page 93)

Those elements that are compatible with the characters already entered are
shown at the top of the list. These elements are also prioritized according to
their frequency of use, i.e. the selection is dynamically adapted to the user’s
actions.
If required, an element in the list can be selected and inserted in the program
text using the Enter key. This makes it unnecessary to type complex variable
names, for example.
Navigation in the “Auto-complete” list:
Scroll
Or: Type the first letter of the desired element. The marker jumps to
the relevant position.

12.4.5.4 Snippets – Fast entry of KRL instructions
Description

A fast entry function is available in the KRL Editor for common KRL instructions.
To program a FOR loop, for example, it is not necessary to enter the entire
syntax FOR … = … TO … STEP …. Instead, the instruction can be selected
from the “Auto-complete” list. All that is then required is to fill out the variable
positions in the syntax manually.

Procedure

On starting to type the code, the “Auto-complete” list is shown. The required
instruction is generally already selected.
1. Accept the selected instruction from the “Auto-complete” list using the Enter key. Or double-click on a different instruction.

Fig. 12-3: Accept with the Enter key, or double-click
2. The KRL syntax is inserted automatically. The first variable position is
highlighted in blue. Enter the desired value.

Fig. 12-4: The first variable position is highlighted in blue
3. Press the TAB key to jump to the next variable position. Enter the desired
value.
4. Repeat step 3 for all other variable positions.
5. To finish editing, press the Enter key.
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The snippet list can also be called separately: Right-click and select Insert
snippet from the context menu.
It is also possible to enter a snippet as follows: Type in the abbreviation and
press the TAB key.
(The abbreviation can be determined by calling the snippet list. Select the instruction. A tool tip is displayed. The 2nd line contains the possible abbreviations.)
12.4.6

Folds

Description

The content of the KRL Editor can be structured with folds just like any normal
KRL program.

Fig. 12-5: Closed fold

Fig. 12-6: Opened fold
Procedure

To open a fold:


Double-click on the box of the closed fold.



Or: Click on the plus sign.

To close a fold:


Click on the minus sign.

To open or close all folds:


12.4.7

Context menu: Folds > Expand all or Collapse all

Jumping to the declaration of a variable

Procedure

1. Place the cursor in the variable name, or directly in front of the first letter
or directly after the last letter.
2. Press F12.
Or: Right-click and select Go to declaration from the context menu.

12.4.8

Quickfix correction
Wavy red lines in the code and marks in the analysis bar indicate errors or discrepancies in the code.
For some of these errors/discrepancies, an automatic correction function – the
“Quickfix” – is offered. A Quickfix light bulb is displayed. Via the arrow button
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next to the light bulb, the user can display various possible solutions and select
one.

Fig. 12-7: Quickfix light bulb
12.4.8.1 Correcting or automatically declaring undeclared variables
Description

Undeclared variables are displayed as follows:


With a wavy red line in the code



With a red mark in the analysis bar

The red color can also refer to a different error, however. If it refers to an undeclared variable, the following tool tip is displayed if you hover with the mouse
over the wavy line or mark: The declaration of variable [name] was not found.
Procedure

1. Place the cursor in the name underlined with the wavy line, or directly in
front of the first letter or directly after the last letter.
Or: Click on the mark in the analysis bar.
The Quickfix light bulb is now displayed next to the variable name.
2. Check if the variable name has been written incorrectly (differently from in
the declaration).


If so: correct. The wavy red line / mark disappears. No further steps are
necessary.



If not: continue with the next step.

3. Move the mouse pointer onto the Quickfix light bulb. An arrow is displayed
next to the light bulb.
Click on the arrow. The following options are displayed:


Declare the variable locally



Declare the variable in the data list

4. Click on the desired option.
5. Only with Declare the variable in the data list: The data list is opened.
Open the fold BASISTECH EXT.
6. A snippet for the variable declaration has been automatically inserted. The
expected data type is highlighted in blue. The declaration is followed by
the comment: ; This variable is for ....


Accept or change the data type, as required.



Press the TAB key to jump to the comment. Edit the comment if required.
This comment is displayed in the tool tip of the “Auto-complete” list if
the variable is selected there.

12.4.8.2 Removing unused variables
Description

Unused variables are displayed as follows:


With a wavy blue line in the code



With a blue mark in the analysis bar

Hovering with the mouse over the wavy line or mark displays a tool tip with a
description.
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Procedure

1. Place the cursor in the name underlined with the wavy line, or directly in
front of the first letter or directly after the last letter.
Or: Click on the mark in the analysis bar.
The Quickfix light bulb is now displayed next to the variable name.
2. Move the mouse pointer onto the Quickfix light bulb. An arrow is displayed
next to the light bulb.
Click on the arrow. The following options are displayed:


Remove declaration



Comment out declaration

3. Click on the desired option.
12.4.8.3 Standardizing the upper/lower case in a variable name
Description

If the use of upper/lower case in a variable name is not uniform in the declaration and in its other occurrences, this is displayed as follows:


With a light blue wavy line in the code



With a light blue mark in the analysis bar

Hovering with the mouse over the wavy line or mark displays a tool tip with a
description.
Procedure

1. Place the cursor in the name underlined with the wavy line, or directly in
front of the first letter or directly after the last letter.
Or: Click on the mark in the analysis bar.
The Quickfix light bulb is now displayed next to the variable name.
2. Move the mouse pointer onto the Quickfix light bulb. An arrow is displayed
next to the light bulb.
Click on the arrow. The following options are displayed:


Change this use to [name as in declaration]



Change declaration to [name as at this point in the program]

3. Click on the desired option.
12.4.9

Creating user-specific snippets

Description

Users can create their own snippets. For this, the required properties must be
saved in a file with the SNIPPET format. This file must then be imported in
WorkVisual. The snippet is then available in the KRL Editor.
A template for a SNIPPET file is provided on the WorkVisual CD in the DOC
directory.

Procedure

Once the SNIPPET file has been created, it must be imported as follows:
1. Select the menu sequence Extras > Import snippet from file …. A window opens.
2. Navigate to the directory where the SNIPPET file is located and select it.
Click on Open.
The snippet is now available in the KRL Editor.

Example 1

A snippet is to be created to insert the following code structure:

Fig. 12-8: Code to be inserted by the snippet
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The snippet is to have the name “User” in the snippet list, and the tool tip
should contain the information shown here:

Fig. 12-9: Desired snippet
The SNIPPET file must have the following format:

Fig. 12-10: Structure of the SNIPPET file
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Line

Description

3 … 48

Section for 1 snippet
A SNIPPET file may contain a number of these sections, i.e. a number of different
snippets.

7

Title displayed in the tool tip

10

Name displayed in the snippet list
Note: The “Auto-complete” function reacts to this character string, i.e. if this string is
entered in the program, the “Auto-complete” list is shown and the corresponding snippet is selected.

13 … 15

Shortcuts for this snippet

18

The snippet is only displayed in the list in files with this extension

21

Description displayed in the tool tip

24

Name of the author displayed in the tool tip

27 … 30

This defines the ways in which the snippet can be inserted.


Expansion: The snippet is inserted at the current cursor position.



SurroundsWith: Before the snippet is inserted, program lines can be selected
in the KRL Editor. The snippet is then automatically inserted so that it surrounds
these lines. The exact position of these lines within the snippet is defined by the
placeholder $selection$.

37

Placeholder occurring in lines 43 … 45, to which lines 38 and 39 refer

38

Tool tip displayed for this placeholder

39

Default value for the placeholder

43 … 45

Program text inserted by the snippet
The text consists of hard text and/or placeholders.

Example 2



$selection$: See description for SurroundsWith.



$end$: This placeholder defines the position of the cursor after insertion of the
snippet has been completed with the Enter key.
An example of the <Snippet> section only:

Fig. 12-11: Code inserted by the snippet
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Fig. 12-12: Structure of the SNIPPET file
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13

Transferring and activating the project

13.1

Generating code

Description

When a project is transferred to the robot controller, the code is always generated first. This procedure can be used to generate the code separately and
thus to check in advance whether generation runs without error.
The code is displayed on the Files tab of the Project structure window.
Automatically generated code is displayed in pale gray.

Fig. 13-1: Example of code generation: before – after
Procedure



Select the menu sequence Extras > Generate code.

The code is generated. When the process is finished, the following messages
are displayed in the message window: The project <"{0}" V{1}> has been
compiled. The results can be seen in the file tree.

13.2

Pinning a project

Description

Projects that are present on the robot controller can be pinned. A project can
be pinned directly on the robot controller or in WorkVisual.
Pinned projects cannot be changed, activated or deleted. They can be copied
or unpinned, however. A project can thus be pinned e.g. to prevent it from being accidentally deleted.

Procedure

Pinning in WorkVisual:
1. Select the menu sequence: File > Browse for project. The Project Explorer is opened. On the left, the Search tab is selected.
2. In the Available cells area, expand the node of the desired cell. All the robot controllers of this cell are displayed.
3. Expand the node of the desired robot controller. All projects are displayed.
Pinned projects are indicated by a pin symbol.
4. Select the desired project and click on the Pin project button. The project
is pinned and labeled with a pin symbol in the project list.
Information about pinning on the robot controller can be found in the
Operating and Programming Instructions for System Integrators
for the KUKA System Software.
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13.3

Assigning the robot controller to the real robot controller

Description

This procedure is used to assign every robot controller in the project to a real
robot controller. The project can then be transferred from WorkVisual to the
real robot controller.

Precondition



A robot controller has been added in WorkVisual.



Network connection to the real robot controller



The real robot controller and the KUKA smartHMI are running.

If the project is subsequently to be transferred and also activated:


The user group “Expert” or higher is selected on the real robot controller.
Restriction: If the activation would cause changes in the area Safety-relevant communication parameters, the user group “Safety recovery” or
higher must be selected.



Procedure

If the operating mode AUT or AUT EXT is selected on the real robot controller: The project contains only settings that affect KRL programs. If the
project contains settings that would cause other changes, it cannot be activated.

1. Click on the Deploy… button in the menu bar. The Project deployment
window is opened.
2. The available cells are displayed under Target cell. (The cells can be renamed by right-clicking.)
If the desired cell is not displayed, a new cell can be created:


Click on New cell. The Cell properties window opens. Enter a name
and, if required, a description. Press OK to save.
The new cell is now shown under Target cell.

3. Select the desired cell under Target cell. This cell must now be assigned
to the real robot controller.
4. Select the desired real robot controller under Available controllers.
Depending on the network topology, it is possible that the robot controller
may not be displayed under Available controllers. If the IP address is
known, the robot controller can be displayed as follows:


Click on
OK.

. A window opens. Enter the IP address and confirm with

The robot controller is now shown under Available controllers.
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Fig. 13-2: Assigning the robot controller to the cell
5. Click on

. The robot controller is now shown under Target controllers.

6. If the project contain more than one robot controller, repeat steps 4 and 5
for the other robot controllers.
7. The virtual robot controller must now be assigned to the real robot controller: Click on Next.
Each virtual robot controller must be assigned to exactly one real robot controller.
8. Select the virtual controller under Controllers in the project.
9. Under Controllers in the cell, select the real robot controller and click on
. The real robot controller is assigned to the virtual robot controller.

Fig. 13-3: Assigning a real robot controller to the virtual controller
10. If the project contain more than one robot controller, repeat steps 8 and 9
for the other robot controllers.
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11. Click on Next. An overview is displayed. (Here it is still possible to change
the assignment if necessary. To do this, click on Change ….)

Fig. 13-4: Overview
12. The project can now be transferred to the robot controller.
(>>> 13.4 "Transferring the project to the robot controller" Page 104)
Alternatively, the project can be transferred at a later point in time. To do
this, click on Cancel: the assignment is saved and the Project deployment window is closed.

13.4

Transferring the project to the robot controller

Description

This procedure is used to transfer the project from WorkVisual to the real robot
controller.
This section describes the procedure for transferring a project to a real robot
controller with KUKA System Software/ VW System Software 8.2.
If a project was transferred to the real robot controller at an earlier
time and has not yet been activated then this will be overwritten if a
further project is transferred.
Transferring and activating a project overwrites a project of the same name
that already exists on the real robot controller (after a request for confirmation).

Precondition



The project has been assigned to the real robot controller.



Network connection to the real robot controller



The real robot controller and the KUKA smartHMI are running.

If the project is also to be activated:


The user group “Expert” or higher is selected on the real robot controller.
Restriction: If the activation would cause changes in the area Safety-relevant communication parameters, the user group “Safety recovery” or
higher must be selected.
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If one of the options KUKA.SafeOperation or KUKA.SafeRangeMonitoring is installed on the robot controller, different user groups may
apply. Information can be found in the documentation for these options.
If a project is transferred containing an option package that has not
yet been installed on the robot controller, then the procedure differs
from the normal one. The following procedure must be observed:
1. Transfer the project to the robot controller, but DO NOT activate it!
2. Install the option package on the robot controller.
Installation is performed in the normal manner. Information about this can
be found in the option package documentation or in the operating and
programming instructions for the KUKA System Software (KSS).
3. Transfer the project back to WorkVisual using the comparison method,
accepting the status as on the robot controller.
(>>> 13.8 "Comparing projects (and accepting differences)" Page 110)
4. Transfer the project back to the robot controller.
5. Activate the project on the robot controller.
Procedure

1. Click on the Deploy… button in the menu bar. The Project deployment
window is opened.

Fig. 13-5: Overview with warning about incomplete configuration
2. If the project has never been transferred back to WorkVisual from a robot
controller before, it will not yet contain all the configuration files. This is indicated by a message. (The configuration files include machine data files,
safety configuration files and many others.)


If this message is not displayed: Continue with step 13.



If this message is displayed: Continue with step 3.

3. Click on Complete. The following confirmation prompt is displayed: The
project must be saved and the active controller will be reset! Do you
want to continue?
4. Answer the query with Yes. The Merge projects window is opened.
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Fig. 13-6: Selecting a project for “Complete”
5. Select a project from which the configuration data are to be transferred,
e.g. the active project on the real robot controller.
If a RoboTeam project is being transferred to the robot controller, always select the active project.
6. Click on Next. A progress bar is displayed. (If the project contains more
than one controller, a bar is displayed for each one.)
(>>> "Progress bars" Page 112)
7. When the progress bar is full and the message Status: Ready for merge
is displayed: Click on Show differences.
The differences between the projects are displayed in an overview.
(>>> "Comparison" Page 112)
8. For each difference, select which state to accept. This does not have to be
done for all the differences at one go.
If suitable, the default selection can also be accepted.
If a RoboTeam project is being transferred to the robot controller for
the first time, accept the complete state of the real robot controller.
For this, activate the check box for every robot controller in the Selected value column.
(>>> 11.4 "Transferring a RoboTeam project to the robot controller"
Page 84)
9. Press Merge to transfer the changes.
10. Repeat steps 8 to 9 as many times as required. This makes it possible to
work through the different areas bit by bit.
When there are no more differences left, the following message is displayed: No further differences were detected.
11. Close the Comparing projects window.
12. Click on the button Deploy... in the menu bar. The overview of the cell assignment is displayed again. The message about the incomplete configuration is no longer displayed.
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Fig. 13-7: Overview
13. Click on Next. Program generation begins. When the progress indicator
bar reaches 100%, the program is generated and the project is transferred.
If a project has been transferred containing an option package that
has not yet been installed on the robot controller:
Do not activate the project, i.e. do not continue with the next step! Observe the note about projects with option packages at the beginning of this
section!
14. Click on Activate.
In the operating modes AUT and AUT EXT, the project is
activated without any request for confirmation if there are
only program changes.
15. Only in operating modes T1 and T2: The KUKA smartHMI displays the request for confirmation Do you want to activate the project […]?. In addition, a
message is displayed as to whether the activation would overwrite a project, and if so, which.
If no relevant project will be overwritten: Confirm with Yes within 30 minutes.
16. An overview is displayed of the changes which will be made in comparison
to the project that is still active on the robot controller. The check box Details can be used to display details about the changes.
If changes are listed in the overview under the heading
Safety-relevant communication parameters, this
means that the behavior of the Emergency Stop and “Operator safety” signal
may have changed compared with the previous project.
After activation of the project, the Emergency Stop and the “Operator safety”
signal must be checked for safe functioning. If the project is activated on several robot controllers, this check must be carried out for every robot controller. Failure to carry out this check may result in death to persons, severe
physical injuries or considerable damage to property.
17. The overview displays the request for confirmation Do you want to continue?. Confirm with Yes. The project is activated on the robot controller. A
confirmation is displayed in WorkVisual.
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Fig. 13-8: Confirmation in WorkVisual
18. Close the Project deployment window by selecting Finish.
19. If the request for confirmation on the robot controller is not answered within
30 minutes, the project is still transferred, but is not activated on the robot
controller. The project can then be activated separately.
(>>> 13.5 "Activating a project" Page 108)
After activation of a project on the robot controller, the
safety configuration must be checked there! If this is not
done, the robot will possibly be operated with incorrect data. Death to persons, severe physical injuries or considerable damage to property may result.
(>>> 13.6 "Checking the safety configuration of the robot controller"
Page 110)
If the activation of a project fails, an error message is displayed in WorkVisual. In this case, one of the following
measures must be carried out:

13.5



Either: Activate a project again (the same one or a different one).



Or: Reboot the robot controller with a cold restart.

Activating a project


A project can be activated on the robot controller from within WorkVisual.
(>>> 13.5.1 "Activating a project (in WorkVisual)" Page 108)



A project can be activated directly on the robot controller.
Information about activation on the robot controller can be found in
the Operating and Programming Instructions for System Integrators for the KUKA System Software.

13.5.1

Activating a project (in WorkVisual)

Precondition



Network connection to the real robot controller



The real robot controller and the KUKA smartHMI are running.



The user group “Expert” or higher is selected on the real robot controller.
Restriction: If the activation would cause changes in the area Safety-relevant communication parameters, the user group “Safety recovery” or
higher must be selected.
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If the operating mode AUT or AUT EXT is selected on the real robot controller: The project can only be activated if this affects only KRL programs.
If the project contains settings that would cause other changes, it cannot
be activated.
If one of the options KUKA.SafeOperation or KUKA.SafeRangeMonitoring is installed on the robot controller, different user groups may
apply. Information can be found in the documentation for these op-

tions.
If a project has been transferred containing an option package that
has not yet been installed on the robot controller:
Do not activate the project! For such projects, the procedure differs
from the usual procedure for transfer and activation. Further information can
be found in the section on project deployment.
(>>> 13.4 "Transferring the project to the robot controller" Page 104)
Procedure

1. Select the menu sequence: File > Browse for project. The Project Explorer is opened. On the left, the Search tab is selected.
2. In the Available cells area, expand the node of the desired cell. All the robot controllers of this cell are displayed.
3. Expand the node of the desired robot controller. All projects are displayed.
The active project is indicated by a small green arrow.
4. Select the desired project and click on the Activate project button. The
Project deployment window is opened.
5. Click on Next.
In the operating modes AUT and AUT EXT, the project is
activated without any request for confirmation if there are
only program changes.
6. Only in operating modes T1 and T2: The KUKA smartHMI displays the request for confirmation Do you want to activate the project […]?. In addition, a
message is displayed as to whether the activation would overwrite a project, and if so, which.
If no relevant project will be overwritten: Confirm with Yes within 30 minutes.
7. On the KUKA smartHMI, an overview is displayed of the changes which
will be made in comparison to the project that is still active on the robot
controller. The check box Details can be used to display details about the
changes.
If changes are listed in the overview under the heading
Safety-relevant communication parameters, this
means that the behavior of the Emergency Stop and “Operator safety” signal
may have changed compared with the previous project.
After activation of the project, the Emergency Stop and the “Operator safety”
signal must be checked for safe functioning. If the project is activated on several robot controllers, this check must be carried out for every robot controller. Failure to carry out this check may result in death to persons, severe
physical injuries or considerable damage to property.
8.

The overview displays the request for confirmation Do you want to continue?. Confirm with Yes. The project is activated on the robot controller. A
confirmation is displayed in WorkVisual.

9. In WorkVisual, close the Project deployment window by selecting Exit.
10. Click on Refresh in the Project Explorer. The active project is now indicated by a small green arrow. (The small green arrow disappears from the
project that was active before.)
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After activation of a project on the robot controller, the
safety configuration must be checked there! If this is not
done, the robot will possibly be operated with incorrect data. Death to persons, severe physical injuries or considerable damage to property may result.
(>>> 13.6 "Checking the safety configuration of the robot controller"
Page 110)
If the activation of a project fails, an error message is displayed in WorkVisual. In this case, one of the following
measures must be carried out:

13.6



Either: Activate a project again (the same one or a different one).



Or: Reboot the robot controller with a cold restart.

Checking the safety configuration of the robot controller

Description

The safety configuration of the robot controller must be checked in the following cases:


After activation of a WorkVisual project on the robot controller



Generally after changes to the machine data (independent of WorkVisual).

If the safety configuration is not checked and updated
where necessary, it may contain incorrect data. Death to
persons, severe physical injuries or considerable damage to property may
result.
Information about checking the safety configuration is contained in
the Operating and Programming Instructions for System Integrators.

13.7

Transferring a project from the robot controller to WorkVisual

Description

On every robot controller to which a network connection is established, a project can be selected and transferred to WorkVisual. This is also possible if this
project is not yet present on this PC.
The project is saved in the directory: My Files\WorkVisual Projects\Downloaded Projects.

Precondition

Procedure



Network connection to the robot controller



No external axes have been added or deleted in the project on the robot
controller.

1. Select the menu sequence: File > Browse for project. The Project Explorer is opened. On the left, the Search tab is selected.
2. In the Available cells area, expand the node of the desired cell. All the robot controllers of this cell are displayed.
3. Expand the node of the desired robot controller. All projects are displayed.
4. Select the desired project and click on Open. The project is opened in
WorkVisual.

13.8

Comparing projects (and accepting differences)

Description
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leave the state as in the current project or to transfer the state from the other
project.
Precondition



The project that is to be compared is open in WorkVisual.

If the other project to be compared is located on a robot controller:

Procedure



The robot controller is running.



Network connection to the robot controller

1. In WorkVisual, select the menu sequence Extras > Compare projects.
The Comparing projects window is opened.
2. Select the project with which the current WorkVisual project should be
compared, e.g. the project of the same name on the real robot controller.

Fig. 13-9: Selecting a project for “Merge”
3. Click on Next. A progress bar is displayed. (If the project contains more
than one controller, a bar is displayed for each one.)
(>>> "Progress bars" Page 112)
4. When the progress bar is full and the message Status: Ready for merge
is displayed: Click on Show differences. The differences between the
projects are displayed in an overview.
(>>> "Comparison" Page 112)
If no differences were determined, this is indicated in the message window. Continue with step 8. After this, no further steps are necessary.
5. For each difference, select which state to accept. This does not have to be
done for all the differences at one go.
If suitable, the default selection can also be accepted.
6. Press Merge to transfer the changes to WorkVisual.
7. Repeat steps 5 to 6 as many times as required. This makes it possible to
work through the different areas bit by bit.
When there are no more differences left, the following message is displayed: No further differences were detected.
8. Close the Comparing projects window.
9. If parameters of external axes have been changed in the project on the robot controller, these must now be updated in WorkVisual:


Open the Machine data configuration window for this external axis.
(>>> 6.17 "Adding an external axis" Page 29)



In the area General axis-specific machine data, click on the button
for importing machine data.
The data are updated.

10. Save the project.
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Progress bars

Fig. 13-10: Example: progress bar
This view shows all the robot controllers which are contained in the project. A
separate bar is displayed for each of these robot controllers. For each bar, the
real robot controller to which the project was last transferred is also specified.
The check boxes are used to select for which robot controllers the comparison
should be carried out.
If additional robot controllers were added or removed in WorkVisual after deployment, these robot controllers are also displayed here. They are marked as
invalid, however, and cannot be selected.
Comparison

The differences between the projects are displayed in an overview. For each
difference, the user can select which state to accept. The default setting is as
follows:


For all elements that are present in the open project, the state of this project is selected.



For all elements that are not present in the open project, the state of the
comparison project is selected.
Exception: For projects with a VKRC 4 controller, the state of the
comparison project is always selected for the long texts.
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Fig. 13-11: Example: overview of differences
Item
1

Description
The node for the robot controller. The various project areas are represented by subnodes. The nodes can be expanded to display the comparisons.
If several robot controllers are present, these are listed one after the other.


In each line, place a check mark in the box for the value that should be transferred.



A check mark next to Not available means that the element will not be transferred,
or that it will be deleted from the project if already present.



If a check box is activated for a node, the check boxes for all subordinate elements
are also automatically activated.
If a check box is deactivated for a node, the check boxes for all subordinated elements are also automatically deactivated.
The subordinate elements can also be edited individually, however.



A filled-in box means: at least one of the subordinate elements is selected, but not
all.

2

State of the project that is open in WorkVisual

3

State of the comparison project

4

Back arrow: The focus in the display jumps to the previous difference.
Forward arrow: The focus in the display jumps to the next difference.
Collapsed nodes are automatically expanded.

5

TRUE: Detailed information is shown for the selected line in the overview.

6

Filter

7

Transfers the selected changes to the open project.
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14

Diagnosis

14.1

Trace
Trace recordings are an important diagnostic tool during start-up of the industrial robot and during troubleshooting. They are also used for optimization of
the machine data. The trace function can be used to record different variables
with the program running, e.g. actual current, setpoint current, states of inputs
and outputs, etc. The recording can then be displayed using the oscilloscope.
In WorkVisual it is possible to configure trace recordings and transfer them to
the robot controller. The recording can also be started in WorkVisual. In addition, trace configurations can be imported from the robot controller to WorkVisual. The results of trace recordings can also be imported to WorkVisual. The
oscilloscope function is also available here for display and evaluation.

14.1.1

Configuring and starting the trace recording

Description

During configuration, the data to be recorded are specified. The robot controller saves the recording in the directory: C:\KRC\ROBOTER\TRACE.

Precondition



Procedure

1. Select the menu sequence Editors > Trace configuration. The Trace
configuration window is opened.

Online administration workspace

2. Select a configuration or create a new configuration on the General tab.
Edit the configuration if required.
(>>> 14.1.4 "“Trace configuration” window" Page 116)
3. In the Cell view window, select the robot controllers to which the configuration is to be transferred.
4. On the General tab, click on the Save configuration on controller button.
5. Respond to the request for confirmation asking whether the configuration
should be activated by pressing Yes.
6. Click on the Start trace button to start the recording. The recording is started in accordance with the defined trigger.
Or: Click on Trigger. The recording starts immediately.
The State box jumps from #T_END to either #T_WAIT or #TRIGGERED.
7. The recording is ended when the State box displays the value #T_END
again.
14.1.2

Importing a trace configuration

Description

Trace configurations can be imported. They are then available under local in
the Source box of the Trace configuration window.

Procedure

1. Select the menu sequence File > Import / Export. The Import/Export
Wizard window is opened.
2. Select Import / export trace configuration and click on Next.
3. Select the Import option.
4. If the desired directory is not displayed in the Source directory box:
Click on Browse and navigate to the directory where the configuration is
located. Select the directory and confirm selection with OK.
The configurations located in the directory are displayed.
5. Specify whether existing data are to be overwritten.
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6. Click on Finish.
7. The data are imported. If the import was successful, this is indicated by a
message in the Import/Export Wizard window. Click on Close to close
the window.
14.1.3

Exporting a trace configuration

Procedure

1. Select the menu sequence File > Import / Export. The Import/Export
Wizard window is opened.
2. Select Import / export trace configuration and click on Next.
3. Select the Export option. All configurations stored locally are displayed.
4. If the desired directory is not displayed in the Target directory box:
Click on Browse and navigate to the desired directory. Select the directory
and confirm selection with OK.
5. Specify whether existing data are to be overwritten.
6. Click on Finish.
7. The data are exported. If the export was successful, this is indicated by a
message in the Import/Export Wizard window. Click on Close to close
the window.

14.1.4

“Trace configuration” window

14.1.4.1 “General” tab

Fig. 14-1: “General” tab

116 / 141

Issued: 29.03.2012 Version: KST WorkVisual 2.4 V3 en

14 Diagnosis

Item
1

Description


local: All the predefined and all the locally saved configurations are available for selection in the Configuration box.



[Robot controller]: All the configurations present on this robot
controller are available for selection in the Configuration box
(in addition to those available under local.)

Robot controllers are only displayed in the Source box if they are
selected in the Cell view window.
2

A configuration can be selected here. The configuration can be
changed.

3

Opens a window in which a name for a new configuration can be
entered. If the name is confirmed with Yes, the new configuration
is inserted in the list under local.
This button is only displayed if the entry local is selected in the
Source box.

4

Deletes the configuration displayed in the Configuration box.

5

Activates the configuration displayed in the Configuration box on
the robot controllers selected in the Cell view window.
If the request for confirmation is answered with No, the configuration is still saved on the robot controller, but is not activated there.

6

Name for the recording. The name can be changed. The robot controller adds extensions to the end of the name, indicating what data
have been recorded.

7

Duration of the recording. Only whole numbers can be entered.
Maximum value: 9999 s

8

The position of the time phase displayed in the recording relative
to the trigger. The % value refers to the duration of the recording.
Examples:


0%: The displayed time phase starts at the trigger.



30%: 30% of the displayed time phase comes before the trigger, 70% after the trigger.



100%: The displayed time phase ends at the trigger.

All of the following elements are only displayed if a robot controller is selected in the Source box.
9
10
11

12

Trace configuration that is currently active on the robot controller.


#T_START: Recording is running.



#T_STOP: Recording is not running.

State of the recording


#T_WAIT: The recording is started and is waiting for the trigger.



#TRIGGERED: The recording continues for the time defined
by the trace length and trigger.



#T_END: No recording is running.

Starts the recording with the configuration displayed under Trace
file. This button is only displayed if no recording has been started
yet.
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Item

Description

13

Stops the recording. This button is only displayed if a recording has
been started.

14

Starts the recording. This button is only displayed if a recording has
already been started.
Strictly speaking, data are recorded as soon as the Start trace button is pressed. The trigger merely controls which time phase of the
recording is then displayed in the trace files.

14.1.4.2 “Trigger” tab
Triggers can be selected here. Triggers control when data is recorded.
Strictly speaking, data are recorded as soon as the Start trace button is
pressed. The trigger merely controls which time phase of the recording is then
displayed in the trace files.

Fig. 14-2: “Trigger” tab
Item

Description

1

A module can be selected here. The modules contain numerous
predefined triggers.

2

This box is only displayed if the selected module refers to the robot
axes. It allows selection of whether the triggers should refer to all
axes or to a particular axis.

3

All the triggers for this module are displayed here.
RIGHT ARROW copies triggers selected here to the Selected trigger box. (Alternatively: double-click on a trigger.)
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Item

Description

4

Depending on the entry selected under available triggers, filters
are available here for this entry.

5

Here the triggers are inserted that are to be used for the current
configuration.
LEFT ARROW removes the triggers selected here. (Alternatively:
double-click on a trigger.)
DOUBLE LEFT ARROW clears this box.

14.1.4.3 “I/O” tab
Here you can select which inputs or outputs are to be recorded.

Fig. 14-3: “I/O” tab
Item

Description

1

All the available inputs/outputs are displayed here.

2

Here a number range can be specified from the entry selected under Available channels.

3

Select the desired recording rate.
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Item
4

Description
Here the inputs/outputs are inserted that are to be recorded with
the current configuration.
RIGHT ARROW transfers all the inputs/outputs selected via Available channels and From ID […] to ID […] to this box. LEFT ARROW removes the inputs/outputs selected here. (Alternative to
these arrow keys: double-click on a channel.)
DOUBLE LEFT ARROW clears this box.

5

Group combines all channels of the same type and with consecutive numbers into a single entry. This gives greater clarity to the
display. It has no effect on the recording.
Ungroup undoes the grouping.

14.1.4.4 “Channels” tab

Fig. 14-4: “Channels” tab
Item
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Description

1

A module can be selected here. The modules contain different
channels.

2

This box is only displayed if the selected module refers to the robot
axes. It allows selection of whether the channels should refer to all
axes or to a particular axis.

3

All the channels for the selected module are displayed here.
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Item
4

Description
Here the channels are inserted that are to be recorded with the current configuration.
RIGHT ARROW transfers all the entries selected under Available
channels to this box. LEFT ARROW removes the entries selected
here. (Alternative to these arrow keys: double-click on an entry.)
DOUBLE LEFT ARROW clears this box.

5
14.1.5

Select the desired recording rate.

Importing a trace recording

Description

To be able to display a trace recording in WorkVisual, it must first be imported.

Precondition



Procedure

1. Select the menu sequence File > Import / Export. The Import/Export
Wizard window is opened.

The recording was created with KSS (or VSS) 8.2 or 8.1 or 5.4.

2. Select Import trace results and click on Next.
3. Click on Browse and navigate to the directory where the results are located. Select the directory and confirm selection with OK.
The trace files located in the directory are displayed.
4. Specify whether existing data are to be overwritten.
5. In the Format box, select the entry (V)KRC 8.1 / 8.2 / 5.4.
6. Click on Finish.
7. The data are imported. If the import was successful, this is indicated by a
message in the Import/Export Wizard window. Click on Close to close
the window.
14.1.6

Displaying a trace recording

Precondition



Online administration workspace



The recording has been imported to WorkVisual.
(>>> 14.1.5 "Importing a trace recording" Page 121)

Procedure

1. Select the menu sequence Editors > Trace Analysis (Oscilloscope).
The Trace Analysis (Oscilloscope) window is opened.
2. On the Channels tab, select a recording.
(>>> 14.1.7.1 "“Channels” tab" Page 122)
3. Select the channels to be displayed.
4. The channels are displayed on the Oscilloscope tab. Adapt the display,
if necessary. (E.g. zoom or change the colors of the traces.)
(>>> 14.1.7.2 "“Oscilloscope” tab" Page 123)
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14.1.7

“Trace Analysis” window

14.1.7.1 “Channels” tab

Fig. 14-5: “Channels” tab
Item
1

Description


local: All the locally saved recordings are available for selection in the Trace recording box.



[Robot controller]: All the recordings present on this robot controller are available for selection in the Trace recording box (in
addition to those available under local.)

Robot controllers are only displayed in the Source box if they are
selected in the Cell view window.
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2

A recording can be selected here.

3

Detailed information regarding the selected recording is displayed
here.

4

Deletes the recording selected in the Trace recording box.
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Item

Description

5

All the channels contained in the selected recording are displayed
here.

6

Here the channels are inserted that are to be displayed in the oscilloscope. It is possible to insert entries from different recordings
in this box.
RIGHT ARROW moves all the entries selected under Available
channels to this box. LEFT ARROW removes the entries selected
here. (Alternative to these arrow keys: double-click on the entry.)
DOUBLE LEFT ARROW clears this box.

14.1.7.2 “Oscilloscope” tab

Fig. 14-6: “Oscilloscope” tab
Check box

Description

Show legend

Activated: The diagram displays which channel
name belongs to which trace color.

Display cursor coordinates

Activated: The X and Y coordinates of the
mouse pointer position are displayed in the diagram.
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Column

Description

Active

Activated: The curve is displayed in the oscilloscope.
Deactivated: The curve is displayed in the oscilloscope.

Trace name

Name of trace

Module name

Name of the module

Channel name

Name of channel

Unit

Unit for the Y axis of the oscilloscope display
(can be different for each curve)

Thickness

Line thickness of the curve (unit: point)

Scaling

This selection box allows the amplitude to be
increased or decreased in steps. In this way, it is
also possible to make curves more visible which
only have a low amplitude or which are hidden
by other curves.

Color

Color of the curve

Points

Activated: The motion blocks of the robot are
displayed. Start and end are shown for each
block.

Values

Activated: The individual values which make up
the curve are displayed as points.

RMS

Activated: The RMS value is shown. Note: The
RMS value refers to the phase of the recording
represented in the oscilloscope.
In electrical engineering, the RMS value is the
root-mean-square value of a signal that changes
over time.
RMS = Root Mean Square

Steps

Activated: The curve runs horizontally on the X
plane from one value until it reaches the Y value
of the next value. From there it runs vertically up
to this Y value.
Deactivated: The curve takes the shortest path
from one value to the next.

14.1.8

Panning and zooming the oscilloscope display

Procedure

Panning:
1. Click in the display and hold down the mouse button.
2. Drag with the mouse. The display moves with the mouse.
Zooming:
1. Click into the display.
2. Scroll with the mouse wheel.
Scroll down: Zoom gets smaller. Scroll up: Zoom gets larger.
Enlarging a section:
1. Hold down the SHIFT key.
2. Click in the display and hold down the mouse button.
3. Move the mouse over the desired section. A gray rectangle is displayed.
The size can be changed by moving the mouse. (The aspect ratio cannot
be changed.)

124 / 141

Issued: 29.03.2012 Version: KST WorkVisual 2.4 V3 en

14 Diagnosis

4. Release the mouse button. The contents of the gray rectangle are displayed in enlarged form.
In this procedure, the aspect ratio of the selected section is adapted to the oscilloscope display:
1. Hold down the CTRL key.
2. Click in the display and hold down the mouse button.
3. Move the mouse over the desired section. A gray rectangle is displayed.
The size and the aspect ratio can be changed by moving the mouse.
4. Release the mouse button. The contents of the gray rectangle are displayed in enlarged form.
Restoring the default view:
1. Right-click in the display.
2. Select Fit to view from the context menu.
14.1.9

Creating a screenshot of the oscilloscope display

Procedure

Creating a screenshot in the clipboard:
1. Right-click in the display.
2. Select Copy screenshot from the context menu.
Creating and saving the screenshot:
1. Right-click in the display.
2. Select Save screenshot from the context menu. A window opens in which
the target directory can be selected. The screenshot is saved there as a
PNG file.

14.2

Displaying diagnostic data about the robot controller

Description

The diagnostic functionality makes it possible to display a wide range of diagnostic data concerning numerous software modules of a robot controller. The
parameters displayed depend on the selected module. The display includes
states, fault counters, message counters, etc.
Examples of modules:


Kcp3 driver (= drive for the smartPAD)



Network driver

“Lamps” indicate the status of the parameters, etc.:

Precondition

Procedure



Green: Status OK



Yellow: Status critical, could be faulty



Red: Fault



Network connection to the robot controller



The robot controller and the KUKA smartHMI are running.



Online administration workspace

1. Select the desired robot controller in the Cell view window. It is also possible to select more than one.
2. Select the menu sequence Editors > Diagnostic monitor. The Diagnostic monitor window is opened.
3. An entry is displayed for each robot controller selected. Expand the entry
for one robot controller.
4. Select a module in the module overview. Diagnostic data are displayed for
the selected module.

Issued: 29.03.2012 Version: KST WorkVisual 2.4 V3 en

125 / 141

WorkVisual 2.4

Fig. 14-7: Diagnostic monitor window (section)
Item

Description

1

Expand/collapse entry for the robot controller

2

Name of the active project on the robot controller
While the connection to the robot controller is being established, a
lamp flashes next to the name. It disappears when the connection
is established.

3

This lamp indicates the status of the robot controller:


Red: When the status of at least one module is red.



Yellow: When the status of at least one module is yellow and
no module is red.



Green: When the status of all modules is green.

Flashing green: Attempting to establish a connection to the robot
controller.
4

Graphical representation of the topology for the following bus topologies:


Controller bus



KUKA Operator Panel Interface

The lamp on a device is gray if the device is not connected to the
real robot controller.
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Item
5

Description
Module overview
Lamps indicate the status of the modules:

6



Red: When the status of at least one parameter is red.



Yellow: When the status of at least one parameter is yellow
and no parameter is red.



Green: When the status of all parameters is green.

Diagnostic data about the selected module
Lamps indicate the status of the parameters:


Red: If the value lies outside of the range defined in the red box
in the Limit values column.



Yellow: If the value lies outside of the range defined in the yellow box in the Limit values column.



Green: If the value lies within the range defined in the yellow
box in the Limit values column.

Diagnostic data:
Column

Description

Name

Diagnosed parameter

Value

Current value of the diagnosed parameter

Extreme values



Upper value: Greatest diagnosed value since the
Diagnosis window was opened



Lower value: Smallest diagnosed value since the
Diagnosis window was opened

Unit

If there is a unit associated with a parameter, this is displayed here. In some cases, the units can be changed
(e.g. from seconds to milliseconds).

Graph over
time

Change of the value over time

Limit values

This column partly contains default values. The values
can be changed/specified by the user.
Yellow box:


Upper value: If this value is exceeded, the parameter is marked yellow.



Lower value: If the current value falls below this value, the parameter is marked yellow.

Red box:

14.3



Upper value: If this value is exceeded, the parameter is marked red.



Lower value: If the current value falls below this value, the parameter is marked red.

Displaying online system information
Online administration workspace

Precondition



Procedure

1. Select the desired robot controller in the Cell view window. It is also possible to select more than one.
2. Select the menu sequence Editors > System information editor. The
System information editor window is opened. An entry is displayed for
each robot controller selected.
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Description

Fig. 14-8: “System information editor” window
Column

Description

Controller Info

Information about the robot controller is displayed here.

Robot info

Information about the robot is displayed here.

Controller status

Shows the status of the Submit interpreter and robot
interpreter and the operating mode.
The status displays correspond to the status displays
on the KUKA smartHMI. Information about this can be
found in the operating and programming instructions
for the KUKA System Software (KSS).

Project Info

Information about the active project is displayed here.

Commands

Edit: Opens the Device properties window.
Create archive: Opens the Generate archives window. (The data for this robot controller can be
archived.)

Button

Description

Archive all

Create archive: Opens the Generate archives window. (The data for all robot controllers selected in the
Cell view window can be archived.)

Device properties window:

Fig. 14-9: “Device properties” window
Item
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Description

1

The name of the robot controller can be changed here.

2

The name of the robot can be changed here.
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Item
3

4

Description
A description can be entered here for information purposes. The
description is displayed in the following places in the Project deployment window:


In the Information area



During activation in the lower window with the progress bar

Activated: If OK is pressed, the RDC data are transferred to the
RDC memory from D:\BackupAll.zip.

Generate archives window:

Fig. 14-10: “Generate archives” window
Item
1

Description
The name of the robot controller is displayed here.
If the window was opened via the Archive all button, the window
displays all the robot controllers that are selected in the Cell view
window.

2

Activated: The log data are also archived.
Deactivated: The log data are not archived.

3

A target directory for the archive can be selected here.
A ZIP file is generated as an archive for each robot controller. The
name of ZIP file always contains the name of the robot and the robot controller.
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15

KUKA Service

15.1

Requesting support

Introduction

The KUKA Roboter GmbH documentation offers information on operation and
provides assistance with troubleshooting. For further assistance, please contact your local KUKA subsidiary.

Information

The following information is required for processing a support request:

15.2



Model and serial number of the robot



Model and serial number of the controller



Model and serial number of the linear unit (if applicable)



Version of the KUKA System Software



Optional software or modifications



Archive of the software



Application used



Any external axes used



Description of the problem, duration and frequency of the fault

KUKA Customer Support

Availability

KUKA Customer Support is available in many countries. Please do not hesitate to contact us if you have any questions.

Argentina

Ruben Costantini S.A. (Agency)
Luis Angel Huergo 13 20
Parque Industrial
2400 San Francisco (CBA)
Argentina
Tel. +54 3564 421033
Fax +54 3564 428877
ventas@costantini-sa.com

Australia

Headland Machinery Pty. Ltd.
Victoria (Head Office & Showroom)
95 Highbury Road
Burwood
Victoria 31 25
Australia
Tel. +61 3 9244-3500
Fax +61 3 9244-3501
vic@headland.com.au
www.headland.com.au
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Belgium

KUKA Automatisering + Robots N.V.
Centrum Zuid 1031
3530 Houthalen
Belgium
Tel. +32 11 516160
Fax +32 11 526794
info@kuka.be
www.kuka.be

Brazil

KUKA Roboter do Brasil Ltda.
Avenida Franz Liszt, 80
Parque Novo Mundo
Jd. Guançã
CEP 02151 900 São Paulo
SP Brazil
Tel. +55 11 69844900
Fax +55 11 62017883
info@kuka-roboter.com.br

Chile

Robotec S.A. (Agency)
Santiago de Chile
Chile
Tel. +56 2 331-5951
Fax +56 2 331-5952
robotec@robotec.cl
www.robotec.cl

China

KUKA Automation Equipment (Shanghai) Co., Ltd.
Songjiang Industrial Zone
No. 388 Minshen Road
201612 Shanghai
China
Tel. +86 21 6787-1808
Fax +86 21 6787-1805
info@kuka-sha.com.cn
www.kuka.cn

Germany

KUKA Roboter GmbH
Zugspitzstr. 140
86165 Augsburg
Germany
Tel. +49 821 797-4000
Fax +49 821 797-1616
info@kuka-roboter.de
www.kuka-roboter.de
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France

KUKA Automatisme + Robotique SAS
Techvallée
6, Avenue du Parc
91140 Villebon S/Yvette
France
Tel. +33 1 6931660-0
Fax +33 1 6931660-1
commercial@kuka.fr
www.kuka.fr

India

KUKA Robotics India Pvt. Ltd.
Office Number-7, German Centre,
Level 12, Building No. - 9B
DLF Cyber City Phase III
122 002 Gurgaon
Haryana
India
Tel. +91 124 4635774
Fax +91 124 4635773
info@kuka.in
www.kuka.in

Italy

KUKA Roboter Italia S.p.A.
Via Pavia 9/a - int.6
10098 Rivoli (TO)
Italy
Tel. +39 011 959-5013
Fax +39 011 959-5141
kuka@kuka.it
www.kuka.it

Japan

KUKA Robotics Japan K.K.
Daiba Garden City Building 1F
2-3-5 Daiba, Minato-ku
Tokyo
135-0091
Japan
Tel. +81 3 6380-7311
Fax +81 3 6380-7312
info@kuka.co.jp

Korea

KUKA Robotics Korea Co. Ltd.
RIT Center 306, Gyeonggi Technopark
1271-11 Sa 3-dong, Sangnok-gu
Ansan City, Gyeonggi Do
426-901
Korea
Tel. +82 31 501-1451
Fax +82 31 501-1461
info@kukakorea.com
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Malaysia

KUKA Robot Automation Sdn Bhd
South East Asia Regional Office
No. 24, Jalan TPP 1/10
Taman Industri Puchong
47100 Puchong
Selangor
Malaysia
Tel. +60 3 8061-0613 or -0614
Fax +60 3 8061-7386
info@kuka.com.my

Mexico

KUKA de Mexico S. de R.L. de C.V.
Rio San Joaquin #339, Local 5
Colonia Pensil Sur
C.P. 11490 Mexico D.F.
Mexico
Tel. +52 55 5203-8407
Fax +52 55 5203-8148
info@kuka.com.mx

Norway

KUKA Sveiseanlegg + Roboter
Sentrumsvegen 5
2867 Hov
Norway
Tel. +47 61 18 91 30
Fax +47 61 18 62 00
info@kuka.no

Austria

KUKA Roboter Austria GmbH
Vertriebsbüro Österreich
Regensburger Strasse 9/1
4020 Linz
Austria
Tel. +43 732 784752
Fax +43 732 793880
office@kuka-roboter.at
www.kuka-roboter.at

Poland

KUKA Roboter Austria GmbH
Spółka z ograniczoną odpowiedzialnością
Oddział w Polsce
Ul. Porcelanowa 10
40-246 Katowice
Poland
Tel. +48 327 30 32 13 or -14
Fax +48 327 30 32 26
ServicePL@kuka-roboter.de

Issued: 29.03.2012 Version: KST WorkVisual 2.4 V3 en

15 KUKA Service

Portugal

KUKA Sistemas de Automatización S.A.
Rua do Alto da Guerra n° 50
Armazém 04
2910 011 Setúbal
Portugal
Tel. +351 265 729780
Fax +351 265 729782
kuka@mail.telepac.pt

Russia

OOO KUKA Robotics Rus
Webnaja ul. 8A
107143 Moskau
Russia
Tel. +7 495 781-31-20
Fax +7 495 781-31-19
kuka-robotics.ru

Sweden

KUKA Svetsanläggningar + Robotar AB
A. Odhners gata 15
421 30 Västra Frölunda
Sweden
Tel. +46 31 7266-200
Fax +46 31 7266-201
info@kuka.se

Switzerland

KUKA Roboter Schweiz AG
Industriestr. 9
5432 Neuenhof
Switzerland
Tel. +41 44 74490-90
Fax +41 44 74490-91
info@kuka-roboter.ch
www.kuka-roboter.ch

Spain

KUKA Robots IBÉRICA, S.A.
Pol. Industrial
Torrent de la Pastera
Carrer del Bages s/n
08800 Vilanova i la Geltrú (Barcelona)
Spain
Tel. +34 93 8142-353
Fax +34 93 8142-950
Comercial@kuka-e.com
www.kuka-e.com
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South Africa

Jendamark Automation LTD (Agency)
76a York Road
North End
6000 Port Elizabeth
South Africa
Tel. +27 41 391 4700
Fax +27 41 373 3869
www.jendamark.co.za

Taiwan

KUKA Robot Automation Taiwan Co., Ltd.
No. 249 Pujong Road
Jungli City, Taoyuan County 320
Taiwan, R. O. C.
Tel. +886 3 4331988
Fax +886 3 4331948
info@kuka.com.tw
www.kuka.com.tw

Thailand

KUKA Robot Automation (M)SdnBhd
Thailand Office
c/o Maccall System Co. Ltd.
49/9-10 Soi Kingkaew 30 Kingkaew Road
Tt. Rachatheva, A. Bangpli
Samutprakarn
10540 Thailand
Tel. +66 2 7502737
Fax +66 2 6612355
atika@ji-net.com
www.kuka-roboter.de

Czech Republic

KUKA Roboter Austria GmbH
Organisation Tschechien und Slowakei
Sezemická 2757/2
193 00 Praha
Horní Počernice
Czech Republic
Tel. +420 22 62 12 27 2
Fax +420 22 62 12 27 0
support@kuka.cz

Hungary

KUKA Robotics Hungaria Kft.
Fö út 140
2335 Taksony
Hungary
Tel. +36 24 501609
Fax +36 24 477031
info@kuka-robotics.hu
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USA

KUKA Robotics Corp.
22500 Key Drive
Clinton Township
48036
Michigan
USA
Tel. +1 866 8735852
Fax +1 586 5692087
info@kukarobotics.com
www.kukarobotics.com

UK

KUKA Automation + Robotics
Hereward Rise
Halesowen
B62 8AN
UK
Tel. +44 121 585-0800
Fax +44 121 585-0900
sales@kuka.co.uk
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Index

Index
A
Add, robot 28
Adding, device 33
Adding, external axis 29
Anchor cross 16, 17
Anchor points 16
Auto-complete 92
B
Bus configuration 45
Bus I/Os, mapping 55
Bus Scan 49
Button bar 19
Button bars 15
Buttons, displaying/hiding 18
C
Catalog Scan 26
Catalog, inserting 26
Catalog, removing 27
Catalogs (window) 16
Close, project 25
Close, WorkVisual 25
Code generation 101
Communication parameters, safety-relevant 39
Configuration, devices 46
Configuration, field bus master 46
Controller bus 68, 70
Copy, project 25
D
Data format 52
Devices, adding 46
Devices, configuration 46
Devices, inserting into bus 49
Diagnosis 115
DTM 8
E
Editing, long texts 63
Export, bus configuration 61
Export, long texts 64
Export, safety configuration 41
Export, subproject 34
Exporting, trace configuration 116
External axes 29, 110
F
Fast entry, KRL 93
Field bus master, add 45
Field bus master, configuration 46
Filtering, signals 56
Folds 94
G
Graphical user interface 15
Graphical user interface, overview 15
Graphics card 13
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Grouping, signals 60
H
Help 15
I
ID, project 24
Import, long texts 63
Import, safety configuration 41
Import, safety zones 42
Importing, machine data 40
Importing, PROFINET configuration 47
Importing, trace configuration 115
Importing, trace recording 121
Insertion, devices into bus 49
Installation 13
Installation, WorkVisual 13
Intel, data format 52
Introduction 7
IO Mapping (window) 55, 56
IP addresses 46, 47
K
KCP 8
Keyboard shortcuts 35
KRL 8
KRL Editor 89
KRL Editor, Folds 94
KRL Editor, opening 89
KSS 8
KUKA Customer Support 131
KUKA smartHMI 8
KUKA smartPAD 8
KUKA.OptionPackageEditor 34
L
Language, changing 36
Licenses 7
Long texts 63
M
Mapping, inputs/outputs 57
Menu bar 15
Messages (window) 16, 21
Motion master 80
Motorola, data format 52
Multiprog 13, 56
O
Open source 7
Operation 23
Operator safety acknowledgement 40
OptionPackageEditor 34
Oscilloscope 115
Overview, graphical user interface 15
P
Peripheral contactor 40
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Pinning 101
Printing, I/O connections 36
Printing, long texts 36
Printing, safety configuration 36
Processor 13
Product description 9
Programming 87
Project Explorer 23
Project information, saving 24
Project structure (window) 15, 21
Project, new 24
Project, open 23
Project, saving 25
Properties (window) 16
R
RAM 13
Required knowledge and skills 7
Robot controller, add 27
Robot controller, removing 28
RoboTeam 75

U
Uninstallation, WorkVisual 14
V
View (menu item) 18
W
Wagon driver 72
Warnings 7
Windows, displaying/hiding 16
Windows, repositioning 16
Workspace master 82
Workspace Selection (window) 16, 18
Workspaces, RoboTeam 82
WVPS 34
WVS 25

S
Safety 11
Safety configuration 39
Safety configuration, components 39
Safety configuration, local 39
Safety instructions 7
Safety master 78
Scan, bus 49
Searching, signals 59
Service, KUKA Roboter 131
Setting to active, robot controller 27
Setting to inactive, robot controller 27
smartHMI 8
smartPAD 8
Snippets 93
Snippets, user-specific 96
Starting, WorkVisual 23
Subproject 34
Support request 131
System requirements, PC 13
System requirements, robot controller 13
System requirements, software 13
T
Target group 7
Template, for project 24
Template, for RoboTeam 75
Terms used 8
Time master 79
Trace 115
Trace, configuration 115
Trace, displaying data 121
Trace, starting 115
Trace, state 117
Training 7
Transferring the project to the robot controller
104
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